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preface

ABOUT THIS GUIDE

This Compaq Service Reference Guide is a troubleshooting and repair guide that can be used for
reference when servicing the Compag Deskpro Personal Computers and Compag | ntel-based
Workstations. Only authorized technicians trained by Compag should attempt to repair this
equipment.

Compag Computer Corporation reserves the right to make changes to all Compaq Personal
Computers and Workstations without notice.

All features identified in this document may not be available on all Compag Products.

Symbols and Conventions

The following text and symbols mark special messages throughout this guide:

A WARNING: Text set off in this manner indicates that failure to follow directions in the warning could result
in bodily harm or loss of life.

& CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage to
equipment or loss of data.

[]  Text set off in this manner presents commentary, sidelights, or clarifying information.

The following warning symbols are located on applicable components of some products and
should be observed to avoid personal injury or component damage:

A @ WARNING: Any surface or area of the equipment marked with these symbols indicates the
presence of a hot surface or hot component. If this surface is contacted, the potential for injury
exists. To reduce risk of injury from a hot component, allow the surface to cool before touching.

A A WARNING: Any surface or area of the equipment marked with these symbols indicates the
presence of electrical shock hazards. The enclosed area contains no operator-serviceable parts.
To reduce risk of personal injury from electrical shock hazards, do not open this enclosure.

A A WARNING: Any RJ-45 receptacle marked with these symbols indicates a Network Interface
Connection. To reduce risk of electrical shock, fire, or damage to the equipment, do not plug
telephone or telecommunications connectors into this receptacle.

Compaq Service Reference Guide vii



Technician Notes

WARNING: Only authorized technicians trained by Compagq should attempt to repair this equipment. All
troubleshooting and repair procedures are detailed to allow only subassembly/module level repair. Because
of the complexity of the individual boards and subassemblies, no one should attempt to make repairs at the
component level or to make modifications to any printed wiring board. Improper repairs can create a safety
hazard. Any indications of component replacement or printed wiring board modifications may void any
warranty.

AN

WARNING: To reduce the risk of personal injury from electrical shock and hazardous energy levels, only
authorized service technicians should attempt to make repairs to this equipment. Do not exceed the level of
repair specified in these procedures.

Because of the complexity of the individual boards and subassemblies, do not attempt to make repairs at
the component level or to make modifications to any printed wiring board. Improper repairs could create
conditions that are hazardous.

CAUTION: To properly ventilate your system, you must provide at least 3 inches (7.6 cm) of clearance at
the front and back of the computer.

CAUTION: The computer is designed to be electrically grounded. To ensure proper operation, plug the AC
power cord into a properly grounded AC outlet only.

[

The installation of options and servicing of this product shall be performed by
individuals who are knowledgeabl e of the procedures, precautions, and hazards
associated with equipment containing hazardous energy circuits.

Additional Documentation

The following documentation is available to support these products:
User Documentation

Technical Training Guides

Compaq Service Advisories and Bulletins

Compaq QuickFind

Compaq Technical Reference Guide

Compaq Service Quick Reference Guide

Compaq Maintenance & Service Guide

Compaq Quick Troubleshooting Guide

viii
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chapter 1

INSTALLING THE OPERATING SYSTEM

1.1

1.1.1

Depending on the model, Microsoft Windows 95, 98, Microsoft Windows 2000 Professional, or
Microsoft Windows NT is preinstalled on the computer and will be configured automatically the
first time the computer is turned on.

& CAUTION: Do not add optional hardware devices to your computer until the operating system is
successfully installed. Doing so may cause errors and may prevent the operating system from installing

properly.

& CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the installation process might damage the
software that runs the computer.

Microsoft Windows 95 or 98

The first time the computer is turned on, Microsoft Windows is automatically installed. This takes
approximately 5 to 20 minutes, depending on the system hardware configuration. At the
beginning of the installation process, the user is prompted to select the appropriate language for
the operating system. Read and follow the instructions that appear on the screen to complete the
installation.

Installing or Upgrading Device Drivers

To install hardware devices such as a printer, a display adapter, or network adapter after the
operating system installation is completed, the operating system needs access to the appropriate
software drivers for the devices.

The Windows Cab files directory and its subdirectories provide the Compag-specific integration
of the operating system and include supported device drivers. The Cab files directory pathis
c:\Windows\Options\Cab. However, if you are using the Compaq Restore CD, the Cab files are
located in c:\Compag\Win95 when using Windows 95 and in c:\Windows\Options\Cab when
using Windows 98.

Compaq Service Reference Guide 1-1



1.2

1.2.1

1.2.3

1.24

Microsoft Windows NT Workstation 4.0 or Windows 2000
Professional

The first time you turn on your computer, the operating system is automatically installed for you.
This takes approximately 10 to 20 minutes, depending on the system hardware configuration. At
the beginning of the installation process, the user is prompted to select the appropriate language
for the operating system. Read and follow the instructions that appear on the screen to complete
the installation.

Installing or Upgrading Device Drivers for Windows NT Workstation 4.0 and
Windows 2000 Professional

To install hardware devices such as a printer, a display adapter, or network adapter after the
operating system installation is completed, the operating system needs access to the appropriate
software drivers for the devices.

The 1386 directory and its subdirectories provide the Compag-specific integration of the operating
system for the computer model and include device drivers supported by Windows NT.

When prompted for the 1386 directory on the operating system CD, replace the path specification
with C:\1386 or use the browse button of the dialog box to browse the computer for the 1386
folder. For Windows NT 4.0, reapply Service Pack 6A by clicking itsicon located on the
computer desktop. For Windows 2000, no further steps are required.

[1  When reapplying the service pack for Windows NT 4.0, if you are prompted to
replace afile with anewer version, always choose Y es.

Thereis no service pack for Windows 2000 Professional.

Creating an Emergency Repair Diskette for Windows NT Workstation 4.0

[] Not al Compag computers equipped with Windows NT support this feature.
This section applies only to computers equipped with a diskette drive.

After installing Microsoft Windows NT, Compag recommends that you create an Emergency
Repair Diskette. Using one blank, formatted diskette, complete the following steps:

1. Click Start & Run.

2. Inthedialog box enter:
C:\RDISK.EXE

3. Read and follow the instructions that appear on the screen.

Using the Emergency Repair Diskette with Windows NT Workstation 4.0

] Not al Compag computers equipped with Windows NT support this feature.

The following section applies only to computers equipped with a diskette drive.
The Emergency Repair Diskette cannot be used on an LS-120 drive.

To use the Emergency Repair Diskette, insert the emergency repair diskette in the diskette drive
and restart the computer. Follow the instructions displayed on the screen.

Installing the Operating System



1.3

1.3.1

1.3.2

Converting to NTFS

Windows NT Workstation 4.0

The hard drive included with a Windows NT Workstation 4.0 model contains a primary FAT16
partition on which the operating system and Compagq software are installed. The rest of the hard
driveis divided into one or more additional partitions. Because FAT16 only supports partitions up
to 2 GB, converting to NTFS will allow hard drives larger than 2 GB to be partitioned as one
large drive. To convert an existing partition from a2 GB FAT 16 partitionto a2 GB NTFS
partition:

1. Click Start - Run.

2. Type CONVERT.EXE X: /[FS:NTFS where X isthe drive |etter designating the partition you
wish to convert.

Alternatively, the Compaq Restore CD can be utilized to repartition the hard drive. The largest
NTFS partition possibleis 7.5 to 8.0 GB, depending on the hard drive, with asecond NTFS
partition created from the remaining space on the drive.

CAUTION: The following procedures will remove all of the software applications and data files from your
hard drive. Be sure to back up any data files you have created prior to converting from FAT16 to NTFS, or
you will not be able to restore them.

You will be able to restore the operating system and drivers required to access the Internet from the
Compaq Restore CD. The operating system (without Compaq software or optimized drivers) may be
restored from the operating system installation CD or diskettes.

If the computer does not have a CD-ROM drive, other means of installation, such as a network
share, will be needed for this procedure.

Insert the Compag Restore CD, version 2.0 or higher, into the CD-ROM drive and turn on or
restart the computer. Read and follow the instructions that appear on the screen to change the
drive partitioning.

Windows 2000 Professional

To convert an existing partition from aFAT 32 partition to an NTFS partition, double-click the
NTFS Convert icon on the desktop. Carefully read and follow the directions that appear on the
screen.

Compaq Service Reference Guide
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1.4

1.5

Registering the Computer

The computer should be registered with Compag. Registration establishes a record of ownership
and gives the user an opportunity to receive product announcements, updates, and other
communications periodically. To register one machine, just visit Compaqg’ s Web site at
www.compag.com/products/registration and follow the instructions that appear on the screen. To
register more than one machine, either telephone in the information or enter the unitsone at a
time on the Compagq Web site.

Compaq Software

The Microsoft Windows 95, 98, Windows NT Workstation 4.0, or Windows 2000 Professional
operating system is preinstalled on the computer and will be configured automatically the first
time the computer is turned on. The following Compaq software will also be installed at that time
on selected models:

Computer Setup Utilities and diagnostic features

Compaq Support Software including device drivers

Compaq Configuration Record

Online Compaq Safety & Comfort Guide

Intelligent Manageability

Enhanced Compaq Insight Personal Edition (Diagnostics for Windows)
DMI Support

Power Management with energy saver features

Security Management tools

Software Support Management tools

Certain drivers and utilities are available only in selected languages. Y ou can obtain the latest
version of these files, in English and selected other languages, in one of three ways:

m  Compaq Support Software CD for Compaq Desktop, Portable, and Workstation Products
(refer to Section 3.4.7, “Enhanced Support Software CD and World Wide Web Site,” for
ordering information)

Compag Web Site at www.compag.com
Compagq Deskpro Supplement CD, which is supplied with many desktop models

1-4
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chapter 2

SETUP UTILITIES AND DIAGNOSTIC FEATURES

2.1

Compag Computer Setup Utilities and diagnostic features provide information needed about the
computer system when contacting Compaqg Customer Support. These tools can also be used to:

B Change factory default settings and to set or change the system configuration, which may
be necessary when you add or remove hardware.

m Determineif al of the devicesinstalled on the computer are recognized by the system and
functioning properly.

Determine information about the operating environment of the computer.

Solve system configuration errors detected but not automatically fixed during the Power-
On Self-Test (POST).
Establish and manage passwords and other security features.
B Establish and manage energy-saving timeouts.
[ All features identified in this chapter may not be available on all Compaqg
products.

Computer Setup Utilities

Use Computer Setup Utilities to do the following:
B Modify or restore factory default settings.
B Set the system date and time.

m  Set, view, change, or verify the system configuration including settings for processor,
graphics, memory, audio, storage, communications, and input devices.

®  Modify the boot order of bootable devices such as hard drives, diskette drives, CD-ROM
drives, DVD-ROM drives, or PD-CD drives.

Configure Quiet Drive options (for drives that support this feature).

Enable Quick Boot which is faster than Full Boot but does not run all of the diagnostic
tests run during a Full Boot. Y ou can set your system to:

0 aways Quick Boot (default);
0 periodically Full Boot (from every 1 to 30 days); or
0 aways Full Boot.

m  Enable or disable Network Server Made, which allows the computer to boot the operating
system when the power-on password is enabled. The keyboard and mouse remain locked
until the power-on password is entered.

Compaq Service Reference Guide
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B Select Post Messages Enabled or Disabled to change the display status of Power-On Self-
Test (POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs,
the error is displayed regardless of the mode selected. To manually switch to Post
Messages Enabled during POST, press any key (except F10 or F12).

B Establish Ownership Tag, the text of which is displayed each time the system is turned on
or restarted.

B Enter the Asset Tag or property identification number assigned by your company to this
computer.

B Enable power-on password prompting during system restarts (warm boots) as well as
during power-on.

m  Establish a setup password that controls access to Computer Setup and the settings
described in this section.

m  Securetheintegrated I/O functionality, including the serial, USB, or parallel ports, audio,
or embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable Master Boot Record (MBR) Security.
Enable or disable removable media boot ability.
Enable or disable removable media write ability.

Solve system configuration errors detected but not automatically fixed during the Power-
On Self-Test (POST).

B Replicate your system setup by saving system configuration information on diskette and
restoring it on one or more computers.

Execute self-tests on a specified IDE hard drive.

Configure various energy-saving features including energy saver mode, system and hard
drive timeouts, power button mode, and power LED behavior.

Using Computer Setup Utilities

To access the Computer Setup Utilities menu, compl ete the following steps:

1. Turnon or restart the computer. To restart the computer in Windows or Windows NT, click
Start &> Shut Down - Restart the Computer.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.
[ If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

Pressing the F12 key initiates Network Service Boot for Remote System
Installation.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage,
Security, Power, and Advanced. Section 2.1.2 in this chapter provides more information
about the features that are available.

3. Using the arrow keys or the Tab key, select the option you want and press the Enter key. To
return to the Computer Setup Utilities menu, press the Esc key.

2-2
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4. To apply and save changes, select File > Save Changes and Exit.

0 If you selected an option that automatically restarted the computer, changes were applied
at that time.

0 If you have made changes that you do not want applied, select Ignore Changes and Exit.

0 If you have already applied changes you now want to eliminate, select Set Defaults and
Exit. This option will restore the origina system defaults.

] Be sure to configure new options and driversin the operating system after they
have been configured by the Setup Utility.
Power-0n Self-Test (POST)

POST isaseries of diagnostic tests that runs automatically when the system is turned on, POST
checks the following items to ensure that the computer system is functioning properly:

Keyboard

Memory modules

Diskette drives

All IDE and SCSI mass storage devices
Processors

Controllers
[ If the Power-On Password is set, akey icon appears on the screen while POST is
running. You will need to enter the password before continuing. Refer to Chapter 3
for information on setting, deleting, or bypassing the password.

If POST finds an error in the system, an audible and/or visual message occurs. Refer to
Appendix D for POST error Messages and their solutions.

Compaq Service Reference Guide

2-3



2.1.2 Computer Setup Menu

Heading  Option Description

File System Information Lists product name, processor type/speed/stepping, cache size,
system ROM family and version, installed memory size, system
board revision, chassis serial number, integrated MAC for
embedded, enabled NIC (if applicable), and asset tracking

number.
Set Time and Date Allows you to set system time and date.
Save to Diskette Saves system configuration to a blank 1.44-MB diskette.
Restore from Diskette Restores system configuration from a diskette.
Set Defaults and Exit Restores factory default settings and clears all passwords.

Ignore Changes and Exit  Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration and exits Computer
Setup.
Storage Device Configuration Lists all installed storage devices. The following options appear

when a device is selected:

Diskette Type (For legacy diskette drives only)

Identifies the highest capacity media type accepted by the
diskette drive. Options are 3.5" 1.44 MB, 3.5" 720 KB,
5.25" 1.2 MB, 5.25" 360 KB, and Not Installed.

Drive Emulation (IDE devices only)

Allows you to select a drive emulation type for a storage device.
(For example, a Zip drive can be made bootable by selecting
disk emulation.)

Drive Type Emulation Options
Hard disk No emulation options available.
Diskette None (treated as diskette drive)

Disk (treated as hard drive)

CD-ROM None (treated as CD-ROM drive)
Diskette (treated as diskette drive)
Disk (treated as hard drive)

Other (e.g., Zip None (treated as Other)

drive) CD-ROM (treated as CD-ROM drive)
Diskette (treated as diskette drive)
Disk (treated as hard drive)

Transfer Mode (/DE devices only)

Specifies the active data transfer mode. Options (subject to

device capabilities) are PIO 0, Max PIO, Enhanced DMA, Ultra
DMA 0, and Max UDMA.

Continued
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Computer Setup Menu Continued
Heading  Option

Storage Device Configuration
(continued)

Description

Translation Mode (/DE disks only)

Lets you select the translation mode to be used for the device.
This enables the BIOS to access disks partitioned and formatted
on other systems and may be necessary for users of older
versions of Unix (e.g., SCO Unix version 3.2). Options are Bit-
Shift, LBA Assisted, User, and None.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be changed.
If the selected translation mode is not compatible with the translation mode that was active when the
disk was partitioned and formatted, the data on the disk will be inaccessible.

Translation Parameters (IDE Disks only)

Allows you to specify the parameters (logical cylinders, heads,
and sectors per track) used by the BIOS to translate disk I/O
requests (from the operating system or an application) into
terms the hard drive can accept. Logical cylinders may not
exceed 1024. The number of heads may not exceed 256. The
number of sectors per track may not exceed 63. These fields are
only visible and changeable when the drive translation mode is
set to User.

Multisector Transfers (IDE ATA devices only)

Specifies how many sectors are transferred per multi-sector PIO
operation. Options (subject to device capabilities) are Disabled,
8. and 16.

Quiet Drive (available on select drives only)

Performance
Allows the drive to operate at maximum performance.

Quiet

Reduces noise from the drive during operation. When set
to Quiet, the drive will not operate at maximum
performance.

If the drive does not support Quiet mode, the Quiet Drive option
will not be displayed.

Removable Media Boot
Enables/disables ability to boot the system from removable
media.

Note: After saving changes to Removable Media Boot, the
computer will restart. Turn the computer off, then on, manually.

Removable Media Write
Enables/disables ability to write data to removable media.

Note: This feature applies only to legacy diskette, IDE LS-120
SuperDisk, and IDE PD-CD drives.

Primary IDE Controller
Allows you to enable or disable the primary IDE controller.
Continued
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Computer Setup Menu Continued
Heading  Option

Storage Device Configuration
(continued)

DPS Self-Test

Boot Order

Security Setup Password

Power-On Password

Password Options

Smart Cover

Description
Secondary IDE Controller

Allows you to enable or disable the secondary IDE controller.

Diskette MBR Validation
Allows you to enable or disable strict validation of the diskette
Master Boot Record (MBR).

Note: If you use a bootable diskette image that you know to be
valid, and it does not boot with Diskette MBR Validation
enabled, you may need to disable this option in order to use the
diskette.

Allows you to execute self-tests on IDE hard drives capable of
performing the Drive Protection System (DPS) self-tests.

Note: This selection will only appear when at least one drive
capable of performing the IDE DPS self-tests is attached to the
system.

Allows you to specify boot order of installed peripheral devices
(such as LS-120 drive, diskette drive, hard drive, SCSI drive,
CD-ROM drive, or DVD-ROM drive).

Enables setup (administrator) password.

See Section 3.2, "Asset Tracking and Security,” for more
information.

Enables power-on password.

See Section 3.2, "Asset Tracking and Security” for more
information.

Enables/disables network server mode.

Specifies prompting for power-on password.

See Section 3.2, "Asset Tracking and Security,” for more
information.

Note: This selection will appear only if a power-on password is
set.

Enables/disables Smart Cover Sensor and Cover Lock. (Feature
supported on select models only.)

Lists most recent cover removal. (Feature supported on select
models only.)

See Section 3.2, "Asset Tracking and Security,” for more
information.
Continued
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Computer Setup Menu Continued

Heading

Security
(continued)

Option
Master Boot Record
Security

Save Master Boot Record

Restore Master Boot
Record

Device Security

Network Service Boot

System IDs

Description

Allows you to enable or disable Master Boot Record (MBR)
Security. When enabled, the BIOS rejects all requests to write to
the MBR on the current bootable disk. Each time the computer is
powered on or rebooted, the BIOS compares the MBR of the
current bootable disk to the previously-saved MBR. If changes
are detected, you are given the option of saving the MBR on the
current bootable disk, restoring the previously-saved MBR, or
disabling MBR Security. You must know the setup password, if
one is set.

Note: Disable MBR Security before intentionally changing the
formatting or partitioning of the current bootable disk. Several
disk utilities (such as FDISK and FORMAT) attempt to update
the MBR. If MBR Security is enabled and disk accesses are
being serviced by the BIOS, write requests to the MBR are
rejected, causing the utilities to report errors. If MBR Security is
enabled and disk accesses are being serviced by the operating
system, any MBR change will be detected by the BIOS during
the next reboot, and an MBR Security warning message will be
displayed.

Saves a backup copy of the Master Boot Record of the current

bootable disk.

Note: Only appears if MBR Security is enabled.

Restores the backup Master Boot Record to the current

bootable disk.

Note: Only appears if all of the following conditions are true:
MBR Security is enabled
A backup copy of the MBR has been previously saved
The current bootable disk is the same disk from which
the backup copy of the MBR was saved

Enables/disables serial, parallel, USB ports, network (some
models) and audio security.

Enables/disables Network Service Boot. (Feature supported on
select models only.)
Allows you to set Asset Tag and Ownership Tag.

Allows setting of Chassis Serial Number if current number is
invalid.

Also allows you to set keyboard locale setting (e.g., English or
German) for System ID entry.

Allows setting of Ownership Tag and UUID.

See Section 3.2, "Asset Tracking and Security,” for more
information.

Continued
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Computer Setup Menu Continued

Heading  Option
Power Energy Saver
Timeouts
Energy Saver Options
Advanced*  Power-On Options

Onboard Devices

PCI Devices

Bus Options

Description

Allows you to set energy saver mode to Advanced, Disabled, or
Minimal.

Note: In the minimal energy saver mode setting, the hard drive
and system do not go into energy saver mode, but the setting
allows you to press the power button to suspend the system.

This option is not available under ACPI-enabled operating
systems.

Allows you to enable/disable timeouts or manually select timeout
values.

Note: This selection will appear only when energy saver mode
is set to advanced. This option is not available under ACPI-
enabled operating systems.

Allows you to set power button configuration (on/off or wakeup.)

Allows user to enable/disable power LED blink in suspend
mode.

Note: This selection will appear only if the energy saver mode is
enabled. This option is not available under ACPI-enabled
operating systems.

Allows you to set POST mode (QuickBoot or FullBoot every N
days where n = 1 to 30) and enables/disables POST messages.

Enables/disables POST messages, Safe Post, F10 prompt, F12
prompt, option ROM prompt, and UUID.

Allows you to select the wakeup boot source (local hard drive or
remote server).

Allows you to select computer state after a power loss (On or
Off)

Allows you to set resources for onboard system devices (serial
port, parallel port, diskette controller, etc.).

Lists currently installed PCI devices and their IRQ settings.
Allows you to reconfigure IRQ settings for these devices or to
disable them entirely.

Enables/disables PCI bus mastering, PCI VGA palette snooping,
PCI SERR# generation, 15 MB memory hole, and ECC on select
models

Allows you to set ISA back-to-back /O (fast/legacy) delay and
bus priority (ISA/PCI).

*These options should be used by advanced users only.

Continued
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Computer Setup Menu Continued

Heading

Advanced*
(continued)

Option
Device Options

PCI VGA Configuration

Description

Allows you to set printer mode (EEP+ECP, Output only, bi-
directional, and NumLock state at power-on.

Enable/disable PME wakeup events, processor cache,
processor number, ACPI thermal mode, and ACPI S3 support.
(When ACPI S3 is enabled you may also enable/disable ACPI
S# video repost and hard disk reset.)

Allows you to select AGP aperture size (4, 8, 16, 32, 64, 128, or
256 MB)

Allows users to specify which VGA controller will be the "boot” or
primary VGA controller.

Appears only if there are multiple PCI video adapters in the
system.

*These options should be used by advanced users only.
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2.2

2.2.1

2.2.2

Computer Diagnostics
[

Compaq strongly recommends that you create a diagnostics diskette as soon as you begin to use
the computer. Thisis a bootable diskette that allows you to test and inspect the hardware outside
of the operating system by running the Computer Checkup (TEST) or View System Information
(INSPECT) diagnostic programs. The diskette will play an important role in the restoration
process if you ever experience amajor system failure.

The following section applies only to computers equipped with a diskette drive.

Another Compag diagnostic feature is Compag Diagnostics for Windows, described later in this
guide.

Create a Diagnostics Diskette

D0S-Based
[] Thefollowi ng section applies only to computers equipped with a diskette drive.

To create a bootable, DOS-based Diagnostic Diskette (some models may require two 1.44-MB
diskettes) run the SOFTPAQ executable file found in C:\DIAGDISK\ to extract the necessary
files. Insert ablank, 1.44MB formatted diskette into the diskette drive, then run
C:\DIAGDISK\PDIAG\MAKEDISK.BAT.

[] Toobtainthe SOFTPAQ executable filename, run
DIR C:\DIAGDISK\SP* .EXE.
Windows-Based
Not al Compag computers equipped with Windows NT support this feature.
Using the Windows or Windows NT operating system:

Click Start > Compaq Information Center - Create Diagnostics Disk. Insert a diskette into the
diskette drive and follow the instructions on the screen.

Computer Checkup (TEST)

Use Computer Checkup (TEST) in the following instances to:

m  Determineif al the devicesinstalled on the computer are recognized by the system and
functioning properly. Running TEST is optional but recommended after installing or
connecting a new device.

[1 Third party devices not supported by Compag may not be detected.

B Save, print, or display the information generated by TEST. Y ou should run TEST and
have the printed report available before placing a call to the Compag Customer Support
Center.

B Reproduce the same environment on another computer for testing.

] Before you run TEST, you must create a diagnostics diskette. See Section 2.2.1,
“Create a Diagnostics Diskette,” for instructions.

1. Turn off the computer.

2. Disconnect al peripheral devices other than the keyboard and monitor. Do not disconnect the
printer if you want to test it or use it to log error messages.

2-10
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Install loop-back and terminating plugs to test external portsif desired.

Cold boot your computer from the diagnostics diskette you have created. Press Enter to bypass
the title screen, if necessary.

5. Select Computer Checkup (TEST)
6. Select the option to view the devicelist. A list of the installed hardware devices appears.
7. Verify that TEST correctly detected the devicesinstalled. This utility will detect all devices

manufactured or supported by Compaq; devices from other manufacturers may not be detected.
O If thelist is correct, select OK and go on to step 8.
0 If thelist isincorrect, be sure that any new devices are installed properly.

Select one of the following from the test option menu:

0 Quick Check Diagnostics—This option runs a quick, general test on each device with a
minimal number of prompts. If errors occur, they are displayed when the testing is
complete. This option will only test the first 16-MB of memory.

0 Automatic Diagnostics—This option runs unattended, maximum testing of each device
with minimal prompts. Y ou can choose how many times to run the tests, to stop on errors,
or to print or file alog of errors.

0 Prompted Diagnostics—This option allows maximum control over the device testing
process. Y ou can choose attended or unattended testing, decide to stop on errors, or
choose to print or file alog of errors.

] If attended testing is selected, the test itself may result in dataloss.

Follow the instructions on the screen as the diagnostic tests are run on the devices. When the
testing is complete, the TEST option menu is displayed again.

9.
] Refer to Appendix Jfor alisting of the Diagnostic Error Codes.

To exit TEST, press the Esc key to reach the Exit option. Then press Enter.

View System Information (INSPECT)
Use View System Information (INSPECT) to:

View information about the system once it has been configured.

Save, print, or display the information generated by INSPECT. Y ou should run INSPECT
and have the printed report available before placing a call to the Compag Customer
Support Center.

Assist your Compag authorized dealer, reseller, or service provider in analyzing the
system by allowing the service provider to reproduce the same environment on another
computer for testing.
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The information provided by INSPECT includes:

Contents of the operating system startup files

Current memory configuration

ROM versions

Type of processor and coprocessor

Diskette, CD-ROM, DVD-ROM tape, or hard drivesinstalled
Active printer and communications interfaces

Modem typeinstalled

Graphics settings

Windows WIN.INI file details

[] Categories or items of information displayed by INSPECT are similar to but may
vary dightly from those available in Compaq Diagnostics for Windows.

[] Before you run INSPECT, you must create a diagnostics diskette. See
Section 2.2.1, “ Create a Diagnostics Diskette,” for instructions.

1. Cold boot your computer from the diagnostics diskette you have created. Press Enter to bypass
the title screen, if necessary.

2. Select View System Information (INSPECT).
3. Select one of the available options using the Esc key:
O Print the INSPECT status.
O Savethe INSPECT statusto afile.
0 Add comments to a parameter status.
0 Exit the utility.
4. Toexit INSPECT, press the Esc key to reach the Exit option. Then press Enter.

224 Compaq Diagnostics for Windows

Compaq Diagnostics for Windows is a component of Intelligent Manageability that allows you to
view:

System overview
AssetControl information
Input devices
Communications ports
Storage devices
Graphicsinformation
Memory configuration
Security management settings
System health

Operating system

Windows version
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Depending on the version, Compaq Diagnostics for Windows may include diagnostic tests to
determine if al the devicesinstalled on the computer are recognized by the system and are
functioning properly.

Using Compaq Diagnostics for Windows

1. Select the Compaq Diagnostics for Windows icon, located in the Control Panel.

2. The screen displays an overview of the computer hardware and software.

3. For specific hardware and software information, select a category from the Categories menu or
from the toolbar.

[] As you move your cursor over the toolbar icons, the corresponding category
names appear near the cursor.

4. Todisplay more detailed information in a selected category, click More in the Information
Level box.

[] Categories or items of information displayed by Compaqg Diagnostics for
Windows are similar to but may vary dlightly from the information presented in
View System Information (INSPECT).

5. Review and print this information.

] To print the information, click File, then select Print. Select one of the following
options: Detailed Report (All Categories), Summary Report (All Categories), or
Current Category. Click OK to print the report you selected.

6. To exit Compaq Diagnostics for Windows, click File, then click Exit.

Running Diagnostic Tests

If your version of Compag Diagnostics for Windows includes diagnostic testing utilities, four tabs
will appear next to Overview: Test, Status, Log, and Error.

1. Select the Test tab.
2. Select one of the following options:

0 Quick Test—Runsaquick, general test on each device with aminimal number of
prompts.

0 Complete Test—Runs maximum testing of each device with minimal prompts.

0 Custom Test—Runs only the tests you select. To select specific devices or tests, find the
deviceinthelist, then click the box beside each test to select or deselect it. When
selected, ared check mark appearsin the box.

3. Select Interactive Mode or Unattended Mode.

4. In Interactive Mode, the diagnostic software will prompt you for input during tests that require
it. Some tests require interaction and will display errors or halt testing if selected in conjunction
with Unattended Mode.

5. Click the Begin Testing button.

Test Status is displayed, showing the progress and result of each test.

6. If errorsare found, click the Error tab to display more detailed information and recommended
actions. By following the recommended actions, you may be able to solve some problems
yourself.
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2.3

2.3.1

23.2

2.3.3

7. Click Print or Save the error information in case you need to contact your Compaq authorized
dealer, reseller, or service provider for assistance.

8. To exit Compaq Diagnostics for Windows, click File, then click Exit.

Protecting Your Software

To protect software from loss or damage, you should keep a backup copy of all system software,
applications, and related files stored on the hard drive. Y ou can order a set of backup diskettes
from Compaq at nominal cost for all of the software preinstalled on the computer, or you can
make a set. Refer to the operating system or backup utility documentation for instructions on
making backup copies of data files. Another option is the Compaqg Deskpro Supplement CD or the
Compaq Restore CD which accompany many desktop and workstation models and enabl es the
user to selectively restore the original system software.

Ordering Backup Diskettes

Y ou can order all software as asingle set, or you can order the various software packages
separately.
] Before calling Compaq to place your order, be sure to have the serial number of
your computer available. This number is necessary for al diskette purchases.

For alist of Compag support tel ephone numbers, consult the Contacting Compaq Customer
Support guide.

Compaq Restore CD

The Compag Restore CD that is shipped with select computers offers easy deployment and
recovery of the system software. Along with the Microsoft operating system CD, the Compaq
Restore CD enables the user to selectively restore the original system software. This can be
extremely helpful in the event of hard drive failure or corruption.

The Compag Restore CD is specific to each desktop and workstation model and accompanies
many computers along with the Microsoft operating system CD.

Compaq Restore CD for Windows NT

The Compag Restore CD for Windows NT that is shipped with select Compaq I ntel-based
workstations is a set of Compag-specific drivers that enables the workstation to operate at
optimum performance. Updates are available on the Compag Web site at www.compag.com and
through subscription to the Compag Support Software CD Kit.

The Compag Restore CD for Windows NT installation program automatically detects the
components on the workstation and determines if the drivers (support software) need to be
updated.

[1  When servici ng the workstation, be sureit is running the latest version of the
Compaq Restore CD for optimum performance. To determine the version of the
Restore CD installed, look at the version in the file properties of the SETUP.EXE
filein the \WINNT\SY STEM32\CPQNTSSD workstation directory.
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The CD has these capabilities:

B Remote capability—Allows the ahility to install, remove, update, and configure
components remotely by machine name (computer name). Supports distributed computing
environments (DCE) perspectives.

B Silent Setup Command Line Interface—Provides the functionality of the Graphical User
Interface (GUI) in asilent command line interface and provides execution output in alog
file. Provides the ability to remotely install or update drivers on multiple remote machines
at one time. Also useful for Microsoft Systems Management Server Configurations.
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chapter 3

DESKTOP MANAGEMENT

Compaq pioneered intelligent manageability in 1995 with the introduction of the industry's first
fully manageabl e desktop personal computers. Since then, Compaq has led an industry-wide
effort to devel op the standards and infrastructure required to effectively manage desktop PCs.
Compaq Intelligent Manageability provides standards-based solutions for managing and
controlling desktops in a networked environment. Compag works closely with leading
management software solution providers in the industry to ensure compatibility between
Intelligent Manageability and these products. Desktop Management is an important aspect of our
broad commitment to providing you with lifecycle management solutions and services to assist
you with the four phases of the desktop PC lifecycle—planning, deployment, management, and
transitions.

This chapter summarizes the capabilities and features of the four key components of Desktop
Management:

m [nitial Configuration and Deployment
B Asset Tracking and Security

m  Fault Notification and Recovery

m  Software Updating and Management

The chapter also contains an overview of the tools, utilities, and information Compag provides to
help you successfully deploy manageabl e desktop PCs.

[] Support for specific features described in this chapter may vary by model or
software version.
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3.1

3.1.1

Initial Configuration and Deployment

Compaqg computers come with a preinstalled system software image. After avery brief software
“unbundling” process, the Compag Deskpro Personal Computer or Workstation is ready to be used.

Y ou may prefer to replace the preinstalled software image with a customized set of system and
application software. There are several methods for deploying a customized software image. They
include:

m [nstaling additional software applications after unbundling the preinstalled software
image

m  Using software deployment tools, such as Microsoft MS Batch or NT Distribution Share
(NTDS) to replace the preinstalled software with a customized software image

m  Using adisk cloning processto copy the contents from one hard drive to another

The best deployment method depends on your information technology environment and
processes. The PC Deployment section of the Deskpro Solutions and Services Web site
(www.compag.com/im/change) provides information to help you select the best deployment
method. You'll also find guides and utilities to integrate with Microsoft or PXE-based
deployment tools.

The Compaqg Restore CD, ROM-based setup, and ACPI-ready hardware provide further
assistance with recovery of system software, configuration management and troubleshooting, and
power management.

Remote System Installation

Remote System Installation allows you to start and set up your system using the software and
configuration information located on a network server. The Remote System Installation feature is
usually used as a system setup and configuration tool, and can be used for the following tasks:

m  Deploying a software image on one or more new PCs.

B Formatting ahard drive.

m [nstaling application software or drivers.

m  Updating the operating system, application software, or drivers.

To initiate Remote System Installation, press F12 when the F12=Network Service Boot message
appears in the lower-right corner of the Compagq logo screen. Follow the instructions on the
screen to continue the process.

Compaqg and Altiris, Inc. have partnered to provide tools designed to make the task of corporate
PC deployment and management easier and |ess time-consuming, ultimately lowering the total
cost of ownership and making Compag PCs the most manageable client PCs in the enterprise
environment.

Altiris eXpress

Altiris eXpress allows the system administrator to create and quickly deploy a customized,
corporate-standard software image across one or more networked client PCs with an interface as
simple to use as Windows Explorer. Altiris eXpress supports Intel’s Wired for Management and
Preboot Execution Environment (PXE). Using Altiris eXpress and the Remote System Installation
features of the Compag computer, there is no need for the system administrator to visit each new
PC individually to deploy the software image.

For more information, refer to the Compag Web site at www.compag.com/easydeploy
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3.2

PC Transplant Pro and PC Transplant for Compaq

PC Transplant, designed to assist you in personalizing the new Compag computer, can be
downloaded free from the Compag Web site. It lets you preserve the “ personality”—the
customized settings such as Start menu entries, drive and printer mappings, software application
options, and so on—of an existing PC, then transfer those unique settings to a Compag PC so that
you don’t have to invest valuable time manually recreating them.

For more information, refer to the Compag Web site at www.compag.com/easydeploy

Asset Tracking and Security

Compaqg AssetControl features incorporated into the computer provide key asset tracking data
that can be managed using Compaq Insight Manager products and Management Solutions
Partners products. Seamless, automatic integration between AssetControl features and these
products enables you to choose the management tool that is best suited to your environment and
to leverage your investment in existing tools.

Compag computers and Professional Workstations are manufactured with the hardware and
firmware required to fully support the DMI 2.0 standard.

Compaq aso offers several solutions for controlling access to valuable components and
information. Security features such as the Smart Cover Sensor and the Smart Cover Lock,
available on select models, help to prevent unauthorized access to the internal components of the
PC. By disabling parallel, serial, or USB ports, or by disabling removable media boot capability,
you can protect valuable data assets. Memory Change and Smart Cover Sensor aerts can be
automatically forwarded to Compag Insight Manager products to deliver proactive notification of
tampering with a computer's internal components.

There are three ways to manage security settings on your Compag computers:

m Localy, using the Compag Computer Setup Utilities. See the Hardware Reference Guide
included with the computer for additional information.

m  Remotely, using the Compag Remote Security Management software. This software
enables the secure, consistent deployment and control of security settings from a central
point on the network using a third-party PC LAN management application such as
Microsoft SMS.

B Remotely, using Compagq Insight Manager LC, atool for managing PC workgroups.

Compaq Service Reference Guide
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The following table and sections refer to managing security features of your Computer locally
through the Compag Computer Setup Utilities. Refer to the Remote Management Setup Utilities
for more information on using the Remote Security Management software. These utilities are
available on the Support Software CD or from the Compag Web site at
www.compad.com/support/files/index.html. For more information on Compagq Insight Manager
LC, refer to www.compag.com/invIc.

Feature*

Removable Media Boot
Control

Serial, Parallel, USB,
or Infrared Interface

Control

Power-On Password

Setup Password

Smart Cover Sensor

Smart Cover Lock

Master Boot Record
Security

Memory Change Alerts

Ownership Tag

Kensington Cable Lock
Provision

Purpose
Prevents booting from the removable media drives.

Prevents transfer of data through the integrated serial, parallel, USB (universal
serial bus), or infrared interface.

Prevents use of the computer until the password is entered. This can apply to both
initial computer startup and restarts.

Prevents reconfiguration of the computer (use of the Computer Setup utility) until
the password is entered.

Indicates that computer cover or side panel has been removed. Can be set to
require the setup password to restart the computer, after the cover or side panel
has been removed.

Prevents unauthorized access to internal components. This is a software-
controllable cover lock, controlled by the setup password.

D The Smart Cover FailSafe key is a device for manually disabling the Smart
Cover Lock, is available from Compaq. You'll need the FailSafe key in case
of forgotten password, power loss, or computer malfunction.

May prevent unintentional or malicious changes to the Master Boot Record of the
current bootable disk, and provides a means of recovering the “last known good”
MBR.

Detects when memory modules have been added, moved, or removed; notifies

end-user and system administrator.

D For information on enabling Memory Change Alerts, refer to the online
Intelligent Manageability Guide.

Displays ownership information, as defined by the system administrator, during
system startup (protected by setup password).

Inhibits access to the interior of the computer to prevent unwanted configuration
changes or component removal. Can also be used to secure the computer to a
fixed object to prevent theft of the computer.

D Install a Kensington cable lock to secure the computer to a fixed object.

For more information about Computer Setup, refer to Section 2.1, “Computer Setup Utilities.” In some
cases switches may need to be set. For more information about these switches, refer to the “Connectors,
Jumpers, and Switches” chapter in the product-specific MSG.

*Not all features are available on all products.
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3.2.1

Password Security

This computer supports two security password features—a setup password and a power-on
password. The power-on password prevents unauthorized use of the computer by requiring entry
of apassword to access applications or data each time the computer is turned on or restarted. The
setup password specifically prevents unauthorized access to Computer Setup, and can also be
used as an override to the power-on password. That is, when prompted for the power-on
password, entering the setup password instead will allow access to the computer.

A network-wide setup password can be established to enable the system administrator to log in to
all network systems to perform maintenance without having to know the power-on password,
even if one has been established.

Establishing a Setup Password Using Computer Setup

Establishing a setup-on password through Computer Setup prevents reconfiguration of the
computer (use of the Computer Setup utility) until the password is entered.

1. Turnon or restart the computer. If you are in Windows, click Start = Shut Down = Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.

1 if you do not press the F10 key while the message is displayed, you must turn
the computer off, then on again, to access the utility.

3. Select Security, then select Setup Password and follow the instructions on the screen.
4. Beforeexiting, click File > Save Changes and Exit.

Establishing a Power-On Password Using Computer Setup

Establishing a power-on password through Computer Setup prevents access to the computer when
power isturned on, unless the password is entered. The password must be entered each time the
computer isturned on, when the key icon appears on the monitor.

1. Turnon or restart the computer. If you are in Windows, click Start > Shut Down - Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.

[] If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

3. Select Security, then Power-On Password and follow the instructions on the screen.
4. Beforeexiting, click File - Save Changes and Exit.
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Entering a Power-0n Password

1. Turnon or restart the computer. If you are in Windows, click Start > Shut Down - Restart
the Compuiter.

2. When the key icon appears on the monitor, enter your current password.

[] Type carefully; for security reasons, the characters you type do not appear on the
screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three
unsuccessful tries, you must turn off the computer, then turn it on again before you can continue.
Changing a Power-0n or Setup Password

1. Turn off or restart the computer. If you are in Windows, click Start > Shut Down - Restart
the Computer. To change the setup password, run Computer Setup.

2. When the key icon appears, type your current password, a slash (/) or alternate delimiter
character, your new password, another slash (/) or alternate delimiter character, and your new
password again as shown:
current password/new password/new password
Type carefully; for security reasons, the characters you type do not appear on the screen.

3. Pressthe Enter key.

The new password takes effect the next time you turn on the computer.

] Refer to the “National Keyboard Delimiter Characters’ section in this chapter for
information about the alternate delimiter characters.

The power-on password and setup password may also be changed using the
Security options in Computer Setup.
Deleting a Power-0n or Setup Password

1. Turnon or restart the computer. If you are in Windows, click Start > Shut Down > Restart
the Computer. To delete the setup password, run Computer Setup.

2. When the key icon appears, type your current password followed by a slash (/) or aternate
delimiter character as shown:

3. current password/
4. Pressthe Enter key.

] Refer to the “National Keyboard Delimiter Characters’ section in this chapter for
information about alternate delimiter characters.

The power-on password and setup password may also be changed using the
Security options in Computer Setup.
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3.2.2

National Keyboard Delimiter Characters

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you
use for changing or deleting your password depend on the keyboard that came with your
computer.

| Arabic = Greek | Russian

= Belgian . Hebrew = Slovakian

= BHCSY* = Hungarian = Spanish

| Brazilian - ltalian | Swedish/Finnish
| Chinese / Japanese = Swiss

= Czech | Korean | Taiwanese

= Danish = Latin American | Thai

! French = Norwegian . Turkish

€ French Canadian - Polish | UK. English

= German = Portuguese | us. English

* . . . . .
For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

Clearing Passwords
If you forget your password you cannot access the computer. Refer to the “ Connectors, Jumpers,
and Switches” chapter in the product-specific MSG for instructions on clearing passwords.

Smart Cover Sensor

Smart Cover Sensor, afeature on select computers, is a combination of hardware and software
technology that can alert you when the computer cover or side panel has been removed. There are
three levels of protection, as described in the following table:

Level Setting Description
Level 0 Disabled Smart Cover Sensor is disabled (default).
Level 1 Notify User When the computer is restarted, the screen displays a message indicating

that the computer cover or side panel has been removed.

Level 2 Setup Password When the computer is restarted, the screen displays a message indicating
that the computer cover or side panel has been removed. You must enter
the setup password to continue.

Setting the Smart Cover Sensor Protection Level

1. Turnon or restart the computer. If you are in Windows, click Start > Shut Down - Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, pressthe F10 key
Press Enter to bypass the title screen, if necessary.

] If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

3. Select Security, then Smart Cover and follow the instructions on the screen.
4. Before exiting, click File > Save Changes and Exit.

Compaq Service Reference Guide
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3.2.3

Smart Cover Lock

The Smart Cover Lock is a software-controllable cover lock featured on some desktop computers.
Thislock prevents unauthorized access to the internal components. Computers ship with the
Smart Cover Lock in the unlocked position.

CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup
password prevents unauthorized access to the Computer Setup utility.

Locking the Smart Cover Lock

1. Turnon or restart the computer. If you are in Windows, click Start - Shut Down - Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10
key. Press Enter to bypass the title screen, if necessary.

[] If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

3. Select Security, then select Smart Cover and follow the instructions on the screen.
4. Beforeexiting, click File - Save Changes and Exit.

Unlocking the Smart Cover Lock

1. Turnon or restart the computer. If you are in Windows, click Start > Shut Down - Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.

[] If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

3. Select Security, then select Smart Cover and the Unlocked option.
4. Beforeexiting, click File > Save Changes and Exit.

Using the Smart Cover FailSafe Key

If you enable the Smart Cover Lock and cannot enter your password to disable the lock, you will
need a Smart Cover Fail Safe Key to open the computer cover. Y ou will need the key in any of the
following circumstances:

m  Power outage

m  Startup failure

m  PC component failure (e.g., processor or power supply)
m Forgotten password

CAUTION: The Smart Cover FailSafe Key is a specialized tool available from Compagq. Be prepared; order
this key before you need one.
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3.24

Master Boot Record Security

The Master Boot Record (MBR) contains information needed to successfully boot from a disk
and to access the data stored on the disk. Master Boot Record Security may prevent unintentional
or malicious changes to the MBR, such as those caused by some computer viruses or by the
incorrect use of certain disk utilities. It also allows you to recover the “last known good” MBR,
should changes to the MBR be detected when the system is restarted.

To enable MBR Security, complete the following steps:

1. Turnon or restart the computer. If you are in Windows, click Start = Shut Down = Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.

Press Enter to bypass the title screen, if necessary.

[] If you do not press the F10 key while the message is displayed, you must restart
the computer to access the utility.

3. Select Security - Master Boot Record Security = Enabled.
4. Select Security - Save Master Boot Record.
5. Before exiting, click File > Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.

[] Most operating systems control access to the MBR of the current bootabl e disk;
the BIOS cannot prevent changes that may occur while the operating systemis
running.

Each time the computer isturned on or restarted, the BIOS compares the MBR of the current
bootable disk to the previously-saved MBR. If changes are detected and if the current bootable
disk is the same disk from which the MBR was previously saved, the following message is

displayed:

1999 - Master Boot Record has changed.

Press any key to enter Setup to configure MBR Security

Upon entering Computer Setup, you must
B Savethe MBR of the current bootable disk;
B Restore the previously-saved MBR; or,
m Disablethe MBR Security feature.
Y ou must know the setup password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR
was previously saved, the following message is displayed:

2000 - Master Boot Record Hard Drive has changed.
Press any key to enter Setup to configure MBR Security
Upon entering Computer Setup, you must
B Savethe MBR of the current bootable disk; or,
m Disablethe MBR Security feature.
Y ou must know the setup password, if one exists.

Compaq Service Reference Guide

3-9



3.25

3.2.6

In the unlikely event that the previously-saved MBR has been corrupted, the following messageis
displayed:

1998 - Master Boot Record has been lost.

Press any key to enter Setup to configure MBR Security

Upon entering Computer Setup, you must
B Savethe MBR of the current bootable disk; or,
m Disablethe MBR Security feature.
Y ou must know the setup password, if one exists.

Before You Partition or Format the Current Bootable Disk

Ensure that MBR Security is disabled before you change partitioning or formatting of the current
bootable disk. Some disk utilities, such as FDISK and FORMAT, attempt to update the MBR. If
MBR Security is enabled when you change partitioning or formatting of the disk, you may
receive error messages from the disk utility or awarning from MBR Security the next time the
computer isturned on or restarted. To disable MBR Security, complete the following steps:

1. Turnon or restart the computer. If you arein Windows, click Start = Shut Down = Restart
the Compuiter.

2. When the F10 Setup message appears in the lower-right corner of the screen, press the F10 key.
Press Enter to bypass the title screen, if necessary.

[] If you do not press the F10 key while the message is displayed, you must restart
the computer to access the utility.

3. Select Security - Master Boot Record Security = Disabled.
4. Beforeexiting, click File - Save Changes and Exit.

The Kensington Cable Lock Provision

The rear panel of the Computer accommodates a cable lock so that the Computer can be
physically secured to awork area.

[1  Thecablelock can be purchased from Kensington Microware Limited or from
Compaq DirectPlus (www.directplus.compag.com). Ask for the Kensington
MicroSaver Security System, Model 64068.

Fingerprint Identification Technology

Eliminating the need to enter end-user passwords, Compaq Fingerprint Identification Technology
tightens network security, simplifies the login process, and reduces the costs associated with
managing corporate networks. Affordably priced and supported by Compag computers, it isn’t
just for high-tech, high-security organizations anymore. See www.compag.com/im/fit/index.html
for more information.
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3.3 Fault Notification and Recovery

Fault Notification and Recovery features combine innovative hardware and software technology
to prevent the loss of critical data and minimize unplanned downtime.

When afault occurs, the computer displays aLocal Alert message containing a description of the
fault and any recommended actions. Y ou can then view current system health by using the
Compag Management Agent. If the computer is connected to a network managed by Compaq
Insight Manager LC, Compag Insight Manager or other management products from Compag
Management Solutions Partners, the computer aso sends a fault notice to the network
management application.

3.3.1 Processor Fault Prediction and Prefailure Warranty

When the processor encounters an excessive number of error checking and correcting (ECC)
cache memory errors, the computer displays alLoca Alert Message. This message contains
detailed information about the faulty processor, allowing you to take action before you experience
non-correctable cache memory errors. The Prefailure Warranty allows you to replace these
processors, free of charge, before they actually fail. Processors with ECC cache memory are
available on select Compaq products.

3.3.2 SMART Hard Drive Fault Prediction for IDE Drives

The SMART hard drive monitors hard drive activity to predict failures and, in some cases, fix
faults before failures occur. Fault prediction and failure indication parameters, such as abnormal
variations in spinup and seek times, or non-correctable read and write errors, are tracked to
determine the hard drive condition. Should these errors become significant, the computer displays
awarning message. The warning gives you time to back up the hard drive and replace it prior to
experiencing downtime or loss of data. The Prefailure Warranty for SMART hard drives alows
you to replace these drives, free of charge, before the drives fail.

SMART hard drives are compliant with the Small Form Factor Committee Specification for Self-
Monitoring, Analysis, and Reporting Technology (SMART). SMART isthe industry standard
technology, pioneered by Compaq and originally called IntelliSafe, that allows you to prevent
data loss and minimize downtime, in concert with Compag Management Agents.

3.3.3 Drive Protection System for IDE Drives

The Compaq Drive Protection System (DPS) is a diagnostic tool built into the hard drives
installed in select Compaq products. DPS is designed to help diagnose problems that might result
in unwarranted hard drive replacement. When Compag products are built, each installed hard
drive is tested using DPS and a permanent record of key information is written onto the drive.
Each time DPS is run, test results are written to the hard drive. Y ou can use this information to
help diagnose conditions that caused you to run the DPS software.

3.3.4 Ultra ATA Integrity Monitoring

Ultra ATA Integrity Monitoring monitors the integrity of data asit is transferred between an Ultra
ATA hard drive and the system’ s core logic. If the computer detects an abnormal number of
transmission errors, the computer displays a Local Alert message with recommended actions. An
alert is also sent over the network to the system administrator.
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3.3.5

3.3.6

3.3.7

3.4

ECC Fault Prediction and Prefailure Warranty

When the computer encounters an excessive number of error checking and correcting (ECC)
memory errors, the computer displays aLocal Alert message. This message contains detailed
information about the errant memory module, alowing you to take action before you experience
non-correctable memory errors. The Prefailure Warranty for ECC memory modules allows you to
replace these modules, free of charge, before the modules actually fail. ECC memory modules are
optional on all Compag personal computers.

[]  Tousethisfeature, you must replace the standard DIMMs or RIMMs with ECC
DIMMsor ECC RIMMs.

Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the computer is hit
with an unpredictable power surge. This power supply is rated to withstand a power surge of up to
2000 volts without incurring any system downtime or data loss.

Thermal Sensor

The thermal sensor is a hardware and software feature that tracks the internal temperature of the
computer. This feature displays a warning message when the normal range is exceeded, which
gives you time to take action before internal components are damaged or datais |ost.

Software Updating and Management

Compaq provides several tools for managing and updating software on desktop computers—
Altiris eXpress, Altiris PC Transplant Pro, PC Transplant for Compaq, Insight Manager LC,
System Software Manager, and Remote Management Setup Utilities. Using Insight Manager LC,
you can also monitor aworkgroup of PCs from a central console and remotely update the system
software, security settings, flash ROM, or hardware device drivers, for each of the managed PCs
individually.

System Software Manager (SSM) is a utility that |ets you update system-level software on
multiple systems simultaneously. When executed on a PC client system, SSM detects both
hardware and software versions, then updates the appropriate software from a central repository,
also known as afile store. Support software that works with SSM is flagged with the PC
Lifecycle Management icon on the Compag Web site. To download the utility or to obtain more
information on SSM, visit the Compag Web site at http://www.compag.com/im.

In addition to its PC configuration capabilities mentioned in a previous section, Altiris eXpress
also includes easy to use software distribution capabilities. Y ou can use Altiris eXpress to update
operating systems and application software from a central console. When used in conjunction
with SSM, Altiris eXpress can also update ROM BIOS and device driver software.

Finally, the Compag Remote Management Setup Utilities, when integrated with M anagement
Solutions Partners products, deliver an on-going management solution. These utilities supplement
the capabilities of Solutions Partners products for distributing new applications, device drivers,
and other system software. The Compag Web site include updated ROM images and device
drivers which can be distributed to client PCs using these software tools.

For more information, refer to the online Remote Management Administrators Guide. The
Remote Management Administrators Guide isincluded with the Remote Management Setup
Utilities, which are available on the Compag Web site at
www.compag.com/support/files/index.html. The following sections provide information on using
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these utilities to accomplish various remote management functions including ROM flash,
changing security settings, and wakeup/shutdown.

3.4.1 Local ROM Flash

To upgrade the ROM:
1. Insert the ROMPaq diskette in the diskette drive and turn on the computer.
2. If prompted, enter the Setup Password.

] If the Setup password is entered correctly, the ROMPag utility will take over and
run the ROM upgrade. If the password is not entered correctly, the procedure will
terminate and no changes will be made to the ROM.

3. When the utility finishes upgrading the ROM, remove the diskette from the diskette drive and
restart the computer.

A CAUTION: Do not turn off the power to the computer until the ROMPaq has completed the upgrade
process.

A CAUTION: To guard against unauthorized updates to the ROM or the system BIOS, the Setup Password
must be set. Refer to Section 3.2.1, “Password Security,” for more information.

3.4.2 Remote ROM Flash

This computer comes with reprogrammable flash ROM (read only memory). By establishing a
setup password in Security Management, you can protect the ROM from being unintentionally
updated or overwritten. Thisisimportant to ensure computer operating integrity. Should you need
or want to upgrade the ROM, you may:

B Order an upgraded ROM Paq diskette from Compag.

®  Download the latest ROM Paqg images from the Compag World Wide Web site
(www.compag.com).

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password
prevents unauthorized ROM upgrades. Compagq Insight Manager LC allows the system administrator to set
the setup password on one or more PCs simultaneously.

Using Remote ROM Flash

Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote
Compaqg Deskpro computers and Compag Professional Workstations, directly from the
centralized network management console. Enabling the system administrator to perform this task
remotely, on multiple computers, results in a consistent deployment of and greater control over
Compaq desktop ROM images over the network. It also results in greater productivity and lower
total cost of ownership.

All desktop ROMPag ROM images from Compag are digitally signed to ensure authenticity and
minimize potential corruption. The ROM firmware includes a Boot Block that is protected during
the flash process and allows the computer to be restarted, in the unlikely event of an unsuccessful
ROM flash.

[] The computer must be powered on, or turned on through Remote Wakeup, to take
advantage of Remote ROM Flash. Use of Remote ROM Flash aso requires an
established setup password.
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3.4.3

For more information on enabling Remote ROM Flash, refer to the online Remote Management
Administrators Guide. The Remote Management Administrators Guide is included with the
Remote Management Administration Tools, and is available on the Support Software CD or at the
Compaqg Web Site at www.compag.com.

FailSafe Boot Block ROM

The Fail Safe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash
failure, for example, if a power failure occurs during a ROM upgrade. The Boot Block is aflash-
protected section of the ROM that checksto validate the system ROM each time power to the
system is turned on.

m | the system ROM isvalid, the system starts normally.

m |[f the system ROM fails the validation check, the Fail Safe Boot Block ROM provides
enough support to start the system from a ROM Paq diskette, which will program the
system ROM with avalid image. The Flash Recovery diskette is a SoftPag downloadable
from the Compagq Website at www.compag.com.

[1 The computer ships with the Diskette Boot feature enabled. If that featureis
disabled, the FailSafe Boot Block ROM will override the disabled feature to
accommodate a system ROM recovery in the event a system ROM failure occurs.

Because there is no video or hard drive support from the Boot Block ROM, the keyboard lights
communicate information. When the Boot Block detects an invalid system ROM, the system
sounds a series of beeps (one long and three short) and flashes the three keyboard lights.

To recover the system after hearing the Fail Safe Boot Block beeps, complete the following steps:
1. Remove any diskettes from the diskette drive and turn off the power.
2. Insert the ROMPaq diskette into the diskette drive.
3. Turn on power to the system.

If asetup password has been established, the Caps Lock light will turn on.

If no ROMPaq diskette is found, you will be prompted to insert one and restart the computer.
4. Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM, then
the three keyboard lights will turn on. A “rising tone” series of beeps also signals successful
completion.
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The following table lists the various keyboard light combinations as well as the meaning and
action associated with each combination.

Num Caps Scroll

Lock Lock Lock Meaning and Required Action

OFF ON OFF System requires setup password.
Enter the setup password. The light remains turned on until you
enter a valid setup password.

ON OFF OFF System could not start from diskette because the ROMPaq diskette
is not present, is bad, or the drive is not ready.
Insert a valid ROMPaq diskette, turn the power off, then turn the
power on.

OFF OFF ON ROM upgrade failed.
Try another ROMPagq diskette. If the light remains turned on,
contact Compaq customer support.

ON ON ON ROM upgrade successfully completed.

Turn power off and back on to resume normal system operation.

[]  Diagnostic lights do not flash on USB keyboards.

Keyboard Lights
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344 Remote Security Management

Remote Security Management allows the system administrator to safely set or modify security
features on remote Compagq desktops, directly from the centralized network management console.
Enabling the system administrator to perform these tasks remotely, on multiple computers, results
in consistent deployment of and greater control over desktop security parameters over the
network. It also resultsin greater productivity and lower total cost of ownership.

[1 The computer must be powered on, or turned on through Remote Wakeup, to take
advantage of Remote Security Management. Use of Remote Security Management
also requires an established setup password.

For more information about the Remote Management Setup software and enabling Remote
Security Management, refer to the online Remote Management Administrators Guide. The
Remote Management Administrators Guide is included with the Remote Management
Administration Tools, and is available on the Support Software CD or at the Compagq Web site at
WWW.Compag.com.

3.4.5 Remote Wakeup and Remote Shutdown

If the computer has an optional network card installed, it may support the Compag Remote
Wakeup and Remote Shutdown functions. These functions allow a system administrator to power
on and power off aclient computer from aremote location, supported by PC LAN management
tools.

[] Thi rd-party software tools are required to remotely distribute software.

Remote Wakeup allows the network interface controller to continue functioning, even when
power to the computer has been turned off.

[] The computer continues to consume a small amount of electricity even after you
turn it off. Only when you disconnect the power cord from the electrical outlet
does the computer stop consuming electricity.

To enable Remote Wakeup and Remote Shutdown, complete the following steps:
Double-click the Network Icon, located in the Control Panel.

Double-click the appropriate network controller.

Click the Advanced Properties tab.

Select Remote Wakeup.

Change the value to ON.

6. Click OK to save and apply changes, then click OK to exit the Network dialog.

o > v D e

For more information on using Remote Wakeup and Remote Shutdown, refer to the online
Remote Management Administrators Guide. The Remote Management Administrators Guideis
included with the Remote Management Administration Tools, and is available on the Support
Software CD or at the Compag Web site at www.compag.com.

3.4.6 NIC Alert

The NIC Alert function enables Compag Deskpro computers to send an immediate alert to the
network administrator when there is a hardware or operating system failure, or evidence of
tampering, even if the system is powered off or the operating system is not yet loaded.
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3.4.7

3.4.8

Replicating Original Setup

This procedure gives an administrator the ability to easily copy one setup configuration to other
computers of the same model. This allows for faster, more consistent configuration of multiple
computers. To replicate the setup:

1. Access the Computer Setup Utilities menu.
2. Click File > Save to Floppy. Follow the instructions on the screen.

[] This requires an internal diskette drive, aMultiBay LS-120 drive, or aportable,
external diskette drive.

3. Toreplicate the configuration, click File = Restore from Floppy, and follow the instructions
on the screen.

Dual-State Power Button

With Advanced Power Management (APM) enabled in Windows 95 or Advanced Configuration
and Power Interface (ACPI) enabled for Windows 98, and Windows 2000, the power button can
function either as an on/off switch or as a suspend button. The suspend feature does not turn off
power altogether, but instead causes the computer to enter alow-power standby. This alows you
to quickly power down without closing applications and to quickly return to the same operational
state without any data loss.

[l The power button suspend feature is not functional in Windows NT 4.0. Under
windows NT, the power switch will act asanormal on/off button even if listed as
“Suspend” in F10 Setup. If you attempt to place the system into the suspend
mode, you could lose valuable data.

To change the power button’s configuration, complete the following steps:
1. Accessthe Computer Setup menu.

2. Select Power - Energy Saver. Set the power button configuration to either Advanced or
Minimal to turn on the Energy Saver Options menu.

3. Select Power->Energy Saver Options. Set the power button configuration to either On/Off or
Suspend/Wakeup, as desired.

For more information about the various screen and configuration options, refer to Section 2.1.1,
“Using Computer Setup Utilities.”

4. Select File > Save Changes and Exit.

After configuring the power button to function as a suspend button, press the power button to put

the system in avery low power state (suspend). Press the button again to quickly bring the system
out of suspend to full power status. To completely turn off all power to the system, press and hold
the power button for four seconds.

] If you have selected the “Blink LED during Energy Save” option in Computer
Setup, the power-on light will blink once every second while the computer isin
suspend. Refer to Section 2.1.1, “Using Computer Setup Utilities’ for more
information.
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3.4.9

3.4.10

Power Management

Power Management is a feature that saves energy by shutting down certain components of the
computer when they are not in use, saving energy without having to shut down the computer.
Timeouts (the period of inactivity allowed before shutting down these components) can be
enabled, customized, or disabled using Computer Setup.

1. Accessthe Computer Setup menu.
2. Select Power->Energy Saver. Select Advanced to turn on the Timeouts menu.
3. Select Power->Timeouts. Enable, customize, or disable timeouts.

Refer to Making Hardware Changes for more detailed information about the features of
Computer Setup.

4. Select File > Save Changes and Exit.

[] Toavoid potential conflicts, never enable monitor timeouts in Windows 95 or
Windows 98 while system timeouts are enabled in Computer Setup.

Use Display Properties to establish, modify, or disable Power Management
settings for the monitor. To access Display Properties, right-click on the Windows
Desktop, then choose Properties.

World Wide Web Site

Compaq engineersrigoroudly test and debug software devel oped by Compag and third-party
suppliers, and develop operating-system specific support software, to ensure the highest level of
performance, compatibility, and reliability for Compag personal computers.

When making the transition to new or revised operating systems, it isimportant to implement the
support software designed for that operating system. If you plan to run aversion of Microsoft
Windows or Microsoft Windows NT Workstation that is different from the version included with
your computer you must install corresponding Compag device drivers and utilities to ensure all
features are supported and functioning properly.

Compaqg has made the task of locating, accessing, evaluating, and installing the latest support
software easier. Y ou can download the software from the Compag World Wide Web site at
WWW.compag.com.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to run
Windows 95, Windows 98, Windows 2000, and Windows NT Workstation on your Compaq
compulter.
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3.5 Building Blocks and Partners

Compag management solutions are based on industry standards, including DMI 2.0, Web-Based
Enterprise Management, Intel's "Wired for Management” (WfM), SNMP, and Net PC
technologies. Microsoft, Intel, Hewlett-Packard, Novell, Veritas, Computer Associates, Tivoli,
and other industry leaders work closely with Compaq to integrate their management solutions
with Compag products and initiatives, giving you, the Compag customer, extraordinary flexibility
and functionality in client management and PC ownership cost reduction.

Compaq delivers desktop management sol utions through the Compag Management Solutions
Partners Program. The partnership ensures that the benefits of Intelligent Manageability are
accessible through a broad range of vendors. For more information and a list of Compag
Management Solutions Partners and their products, visit
www.compag.com/im/partners/index.html on the Compaq Web site.

3.5.1 Desktop Management Interface (DMI)

The Desktop Management Task Force (DMTF) is an industry body created in 1992 with the goal
of standardizing systems manageability. DM TF established the Desktop Management Interface
(DMI) framework to standardize access to PC configuration data. Compaq, as a Steering
Committee and Technical Committee member of the DMTF, delivers hardware and software
instrumentation that supports the DMI standard.

For more information on configuring the DMI software, refer to the online Intelligent
Manageability Guide.
3.5.2 Wired for Management

Intel's Wired for Management initiative is focused on reducing the support and administration
cost of Intel architecture-based systems without compromising their flexibility and performance.
The Wired for Management guidelines provide a baseline set of building blocks that Compaq
utilizes in Intelligent Manageability to provide standardized management of desktop inventories,
remote system configuration, off-hours maintenance, and next generation power management.
But Compaqg doesn't stop with these baseline features. Additional capabilities have been
incorporated into Intelligent Manageability to provide an extensive solution for managing
networked computing environments.

Required Wired for Management technologies include:
Desktop Management Interface (DMI) 2.0
Remote System Installation

Remote Wakeup and Remote Shutdown
ACPI-Ready Hardware

SMBIOS

Pre-boot execution (PXE) support
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chapter 4

IDE/ATAPI DEVICE SEQUENCING GUIDELINES

This guideline standardizes the configuration of multiple IDE/ATAPI storage devices. It
categorizes the devices by the type of media used and then ranks the device within each class.

Device Class
Class 1 Class 2 Class 3
Hard Drives Magnetic Storage Optical Storage
2.1 LS-120 3.1 R/W CD-ROM Drive
2.2 Tape Drive 3.2 DVD-ROM Drive
2.3 lomega Zip Drive 3.3 CD-ROM Drive
4.1 General Application Rules

1. When possible, hard drives should be configured by themselves on the primary controller
channel.

2. When devices from all three classes are present, class 2 and 3 devices should be combined first
on the secondary controller channel.

3. When combining two devices on any controller channel, the device with the lower rank should
be the primary device (master) and the higher rank the secondary device (slave).

4. Thelowest class present in a configuration consisting of four devices should be placed on the
primary channel with the hard drive.

5. Asnew devices are devel oped and added to the individual class lists they will be added to the
bottom of the lists. Thisimproves the chances that the new device will be configured as a
primary drive (master) and lowers the chances that it will be combined with a hard drive.

6. When two hard drives are installed in a computer, an 80-pin cable should be used. When other
multiple ATAPI devices are used, a 40-pin cable is recommended.

4.2 Special Situations

1. When combined with the lomega Zip drive on the same controller, the DVD drive must be
configured as the primary drive.

2. Inall applications except an NLX minitower chassis, when an LS-120 driveis being
configured, it is assumed that the diskette drive is not present.

3. When aDVD drive using A50H firmware and an lomega Zip drive are on the same controller,
the DVD drive must be configured as the primary drive. When the DVD drive firmwareis
AS53H, this configuration is not required.

4. DVD drives are supported on some computers that use the Intel 810 chipset. Refer to the
specific documentation that came with the computer for applicability.
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5. Onall BX platforms, the LS-120 drive should be sequenced as the primary drive on the
secondary channel and system board jumper P33 must be removed.

6. Onall 810 platforms, the L S-120 should be sequenced as the primary drive on the secondary
channel and system board jumper E23 must be removed.

4-2 IDE/ATAPI Device Sequencing Guidelines



chapter 5

SCSI GUIDELINES

When installing and operating SCSI devices, you must follow these guidelines:

A narrow SCSI controller allows you to daisy-chain up to 7 additional SCSI devices.
Counting the controller, that amounts to 8 total SCSI devices.

A single Ultra SCSI, Ultra-Wide SCSI, or Wide-Ultra SCSI controller allows you to daisy-
chain up to 15 additional SCSI devices. Counting the controller, that amounts to 16 total
SCSI devices.

If two SCSI controllers are each connected to separate system board SCSI connectors,
each controller may have seven SCSI devices attached. Thiswill give atotal of 16 SCSI
devices on the system.

Compaq does not recommend mixing different width SCSI devices on the same SCS|
chain or on the same SCSI controller. Mixing devices of different widths on the same
chain or controller will aways result in a data transfer rate of the slowest machine in that
chain.

If two controllers are used, each may use SCSI devices having widths and speeds different
from the other. If a 68-pin data cable is used on a controller having 50-pin SCSI devices,
use an internal cable adapter (Compag number 199618-001) or an external cable adapter
(Compag number 270187-B21).

CAUTION: Do not route data cables near the air intake to the power supply. Cables routed in this manner

may block the airflow and cause the computer to overheat.

The Ultra SCSI, Ultra-Wide SCSI, or Wide-Ultra SCSI controller requires a unique SCSI
ID (0-7 or 8-15) for each SCSI device installed. The controller identifies a SCSI device by
its SCSI ID number rather than its location. Moving a SCSI device from one position to
another on the SCSI chain does not affect communication between the controller and the
device. Thereserved and available SCSI 1D numbers for SCSI devices are:

O Oisreserved for the primary hard drive.
0 7isreserved for the SCSI conroller.
0 1through 6 and 8 through 15 are available for all other SCSI devices.

Every SCSI chain or circuit must be terminated (closed) at both ends. Some system boards
have both ends of the SCSI cable connected to, and terminated by, the system board.
Termination can be accomplished in one of several ways:

Use a cable with a built-in terminator.
Use a cable with aterminating resistor plug in the last connector.
Connect a SCSI device with its termination enabled into the last connector.

Connect an external SCSI device with its termination enabled to the external SCS
connector on the rear panel of the computer.

O 0o o o
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B For workstations, if only one SCSI hard driveis used, it should be installed in the lowest
numbered bay (bay 1). (Refer to the product-specific MSG for application).

B All SCSI hard drives must be either internal or external, but never both. The system
accommodates a combination of other internal and external SCSI devices, such as tape and
CD-ROM drives.

®  Turnonall external SCSI devices before turning on the power to the computer. This
enables the SCSI controller to recognize the external devices.

Using the Multi-Mode SCSI Cable

Some products ship standard with a three-device multi-mode SCSI cable having aterminator @
on one end. This cable supports both low voltage differential (LVD) and single ended (SE)
devices. One end of the cable connects to the internal LV D/SE connector on the system board,
while the remaining three connectors being used on the hard drives in the hard drive bays. The
third device circuit must be used.

[]  Themulti-mode cable included with the computer may differ from the one
pictured.

For additional information about installing optional SCSI devices, refer to the documentation
included with the device option kit.

5-2 SCSI Guidelines



appendix A

CONNECTOR PIN ASSIGNMENTS

This appendix contains the pin assignments for many computer and workstation connectors.
Some of these connectors may not be used on the product being serviced.

Connector and Icon

Connector and Icon

Connector and Icon

Connector and Icon

o O

1357
2746 8

EIE

[EIE]

=

Enhanced Keyboard

Pin Signal
1 Data

2 Unused
3 Ground
4 +5 VDC
5 Clock

6 Unused

Mouse

Pin Signal
1 Data

2 Unused
3 Ground
4 +5VDC
5 Clock

6 Unused

Ethernet BNC

Pin Signal
1 (Inside) Data

2 (Outside)  Ground

Ethernet RJ-45

Pin Signal
(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused
Unused
(-) Receive Data
Unused
Unused

0 N O BsEWwW N =
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Ethernet AUI
Connector and Icon Pin Signal

1 Ground
loYololelololelo) EIRgEI 2 Negative AUI Differential Collision
\ OO | 'ﬁ 3 Positive AUI Differential Collision
4 Negative AUI Differential Transmit
5 Positive AUI Differential Transmit
6 Ground
7 Ground
8 Negative AUI Differential Receive
9 Positive AUI Differential Receive
10 +12V
11 Ground
12 Ground
13 Not Used
14 Not Used
15 Not Used
16 Not Used

Parallel Interface

Connector and Icon Pin Signal
1 Strobe
2 Data Bit 0
\@@@@@@@@@@@ m 3 Data Bit 1
EEOOODDB®O® @D 4 Data Bit 2
5 Data Bit 3
6 Data Bit 4
7 Data Bit 5
8 Data Bit 6
9 Data Bit 7
10 Acknowledge
11 Busy
12 Paper End
13 Select
14 Auto Linefeed
15 Error
16 Initialize Printer
17 Select IN
18-25 Signal Ground

A-2
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Connector and Icon

LO®®WE

®D® @

Connector and Icon

] o=

Connector and Icon (1/8" miniphone)

123

S r—

Connector and Icon (1/8" miniphone)

123 m

Connector and Icon (1/8" miniphone)

123 J@

Connector and Icon (1/8" miniphone)

123 J:>

1(
2 (
3(

1(
2 (
3(

Pin

O© 00 N O O b W N =

UsB
Pin

B wWw N =

Microphone

Pin
1 (Tip)

2 (Ring)
3 (Shield)

Headphone

Pin
1 (Tip)

2 (Ring)
3 (Shield)

Pin
Tip)

Pin
Tip)

Ring)
Shield)

Ring)
Shield)

Serial Interface

Signal

Carrier Detect
Receive Data
Transmit Data

Data Terminal Ready
Signal Ground

Data Set Ready
Request to Send
Clear to Send

Ring Indicator

Signal
VCC

B Data
+ Data
Ground

Signal
Audio
Power
Ground

Signal
Audio_Left
Audio_Right

Ground

Line-In Audio

Signal
Audio_In_Left
Audio_In_Right
Ground

Line-Out Audio

Signal
Audio_Out_Left
Audio_Out_Right
Ground
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SCSI Low Voltage Differential/Single Ended (LVD/SE)

Connector and Icon

0000000000000000000000000000000000 N
0000000000000000000000000000000000

Pin Signal Pin Signal

1-16 Ground 43 -D3

17-18  TERMPWR 44 -D4

19 Reserved 45 -D5

20-34  Ground 46 -D6

35 -D12 47 -D7

36 -D13 48 -DPO

37 -D14 49-50 Ground

38 -D15 51-52 TERMPW

39 -DP1 53 Reserved

40 -DO 54 Ground

41 -D1 55 -ATN

42 -D2 56 Ground

Ultra SCSI

Connector and Icon

lE=== (-

Pin Signal Pin Signal
1-11 Ground 31 DB5

12 Reserved 32 DB6

13 Open 33 DB7

14 Reserved 34 DBP
15-25 Ground 35 Ground
26 DBO 36 Ground
27 DB1 37 Reserved
28 DB2 38 TERMPWR
29 DB3 39 Reserved
30 DB5 40 Ground

Pin

57
58
59
60
61
62
63
64
65
66
67
68

Signal

-BSY

-ACK

-RST

-MSG

-SEL
-C/D

-REQ

-1/0
-D8
-D9
-D10
-D11

Pin
41
42
43
44
45
46
47
48
49
50

Signal
ATN #
Ground
BSY #
ACK #
RST #
MSG #
SEL #
C/D
REQ #
Input/Output
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External Infrared Transceiver
Connector and Icon Pin Signal

Transmit
PN
C.\\

Big)
o]a|
EE

Receive

3]
3]

Ground
5V

Mode
Not Used
Not Used
Not used

0 N O OB~ W N =

Monitor

Connector Pin Signal

Red Analog
Green Analog
Blue Analog
Monitor 1D
Ground

Ground

Ground

Ground

+5V DC

Ground

Monitor ID

DDC Serial Data
Horizontal Sync
Vertical Sync
DDC Serial Clock

®®@@@®®@
©® W

0 N O W N =

_ A A a4 a4
g~ 0w - O
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IDE/EIDE Drive Gable

Connector
39 1
OO0 0o oDoDo0oooDooooogooogooaog
HEI Oo0oo0o0oooooaog OO0o0oo0ooOooogaog EIH
40 2
Pin Signal Pin Signal Pin
1 RESET 15 DD1 29
2 GROUND 16 DD14 30
DD7 17 DDO 31
DD8 18 DD15 32
DD6 19 GROUND 33
6 DD9 20 (KEY) 34
7 DD5 21 DMARQ 35
8 DD10 22 GROUND 36
9 DD4 23 DIOW 37
10 DD11 24 Ground 38
11 DD3 25 DIOR 39
12 DD12 26 GROUND 40
13 DD2 27 IORDY
14 DD13 28 CSEL

Signal
DMAK
GROUND
INTRQ

I0CS16
DA1
PDIAG (80-pin cable detect)

DAO
DA2
CS1FX

CS3FX
DASP
GROUND

A-6
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Slimline CD-ROM Adapter
Connector

@1 34@

35 68
Pin Signal Pin Signal Pin Signal Pin Signal
1 RESDRV_ 18 D15 35 AO 52 FPO5
GROUND 19 GROUND 36 A2 53 FPO6
DO7 20 (KEY) 37 CS1FX 54 FPO7
4 D08 21 DRQ 38 CS3FX 55 FPO8
D06 22 GROUND 39 DASP 56 FPO9
6 D09 23 IOW 40 GROUND 57 FP10
7 D05 24 GROUND 41 +5VMLOG 58 FP11
8 D10 25 IOR 42 +5VMOT 59 FP12
9 D04 26 GROUND 43 GROUND 60 FP13
10 D11 217 IOCHRDY 44 AUDIO_L 61 FP14
11 D03 28 CABLE SELECT 45 A_GROUND_R 62 FP15
12 D12 29 DAK 46 A_GROUND_L 63 FP16
13 D02 30 GROUND 47 AUDIO_R 64 FP17
14 D13 31 IRQ 48 FPO1 65 FP18
15 D01 32 1016 49 FP02 66 FP19
16 D14 33 Al 50 FPO3 67 FP20
17 D00 34 PDIAG 51 FPO4 68 FP21
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Accelerated Graphics Port (AGP)

Connector
A\1 A21 A26 A/66
EI]I]I]I]I]I]I]I]I]I]I]I]I]I]I]I]I]I]I]E JI]I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]IZII]IZII]I]I]I]IZIJ
?I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]I]I]IZI}] [{I]I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]I]I]IZII]I]I]I]IZII]IZII]I]I]I]IZI[{
/ \
B1 B21 B26 B66
Signal A Signal B Signal A Signal B
Pin Pin
1 +12V OVRCNT# 23 Ground Ground
2 TYPEDET# + 5V 24 Reserved 3.3 Vaux
3 Reserved + 5V 25 VCC 3.3 VCC 3.3
4 USB- USB+ 26 AD30 AD31
Ground Ground 27 AD28 AD29
6 INTA# INTB# 28 VCC 3.3 VCC 3.3
7 RST# CLK 29 AD26 AD27
GNT# REQ# 30 AD24 AD25
9 VCC3.3 VCC3.3 31 Ground Ground
10 ST1 STO 32 AD_STB1# AD_STB1
11 Reserved ST2 33 C/BE3# AD23
12 PIPE# RBF# 34 Vddq Vddq
13 Ground Ground 35 AD22 AD21
14 WBF# Reserved 36 AD20 AD19
15 SBA1 SBAO 37 Ground Ground
16 VCC 3.3 VCC 3.3 38 AD18 AD17
17 SBA3 SBA2 39 AD16 C/BE2#
18 SB_STB# SB_STB 40 Vddq Vddq
19 Ground Ground Y| FRAME# IRDY#
20 SBA5 SBA4 42 Reserved 3.3VAux
21 SBA7 SBA6 43 Ground Ground
22 Reserved Reserved 44 Reserved Reserved

Pin
45
46
47

48
49
50

51
52
53

54
55
56

57
58
59

60
61
62

63
64
65
66

Signal A

VCC 3.3
TRDY#
STOP#

PME#
Ground
PAR

AD15
vddg
AD13

AD11
Ground
AD9

C/BEO#
Vvddg
AD_STBO#

ADG6
Ground
AD4

AD2
Vddg
ADO
VREFGC

Signal B

VCC 3.3
DEVSEL#
vddg

PERR#
Ground
SERR#

C/BE1#
Vvddg
AD14

AD12
Ground
AD10

AD8
Vvddg
AD_STBO

AD7
Ground
AD5

AD3
Vddg
AD1
VREFCG
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Connector and Icon

Ultra SGSI

lE=== <
Pin Signal Pin Signal Pin
1-11 Ground 31 DB5 41
12 Reserved 32 DB6 42
13 Open 33 DB7 43
14 Reserved 34 DBP 44
15-25 Ground 35 Ground 45
26 DBO 36 Ground 46
27 DB1 37 Reserved 47
28 DB2 38 TERMPWR 48
29 DB3 39 Reserved 49
30 DB5 40 Ground 50
IDE CD-ROM

Connector

49 1

;0 DDDDDDDDDDDDDDDDDDDDDD 2

Pin Signal Pin Signal Pin Signal

1 RESDRV_ 14 GROUND 27 D07

2 D06 15 D09 28 D05

3 D04 16 D11 29 D03

4 D02 17 D13 30 DO1

5 D00 18 D15 31 Ground

6 DREQ 19 Ground 32 IOW

7 IOR 20 Ground 33 OCHRDY
8 DAK 21 Ground 34 IRQ

9 Al 22 PDIAG 35 AO

10 CS1FX 23 CS3FX 36 DASP

11 AUDIO_R 24 AUDIO_L 37 A_GND_R
12 +5VMOT1 25 +5VMOT?2 38 +5VMOT3
13 +5VMLOG1 26 +5VMLOG2 39 DASP

Signal

ATN #

Ground

BSY #

ACK #

RST #

MSG #

SEL #

C/D

REQ #

Input/Output

Pin Signal

40 D08

41 D10

42 D12

43 D14

44 (KEY)

45 Ground
46 CABLE SELECT
47 1016

48 A2

48 Ground
49 A_GND_L
50 +5VMOT4
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Connector for BX Chipset

1 13
(«)[=][=](a)Ce)[=][=]
[=]0e) (&) [=][=](=)Ta)
Pin Signal
1 +3.3V

+3.3 V Sense
RTN
+5V

Pin

6

Signal
RTN

+5V
RTN
+3.3V

14-Pin Power

Pin

10
11
12

14-Pin Power

Connector for 810, 810e, and 820 Chipsets

1 13
(@I[=][=](=J) =] [=]
(=)&) [=][=]{=] (]
Pin Signal Pin
1 +3.3V 5
2 +3.3 V Aux 6
3 RTN 7
4 +5V 8
Connector
1 19
()= ][=]() () e ][w]Ca)Ca) e]
()&= ][=](e] ] [=][=]Ce)
2 20
Pin Signal Pin
1 +3.3V 6
2 +3.3V
3 RTN
4 +5V
5 RTN 10

Signal
RTN
+5V
RTN
+3.3V

Pin

10
11
12

Signal Pin
12V 13

Fan OFF 14

ON/STBY

+5 V Aux

Signal Pin
12V 13

Fan OFF# 14

ON/STBY

+5 V Aux

20-Pin Power - Deskpro EP

Signal
+5V
RTN

Fan OFF
+5 V Aux
+12V

Pin
11
12
13
14
15

Signal Pin
+3.3V 16
12V 17
RTN 18
ON/STBY 19
RTN 20

Signal

+3.3 V Sense
return

+12V

Signal
Fan speed
+12V

Signal
RTN
RTN
-5V
+5V
+5V
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20-Pin Power - Deskpro EN

24-Pin Power

Connector
1 19
(=)[=][=](e)Ca) =] =] () Ca) =]
[=](=) (=) [=][=](=) () [=][=](a]
2 20
Pin Signal Pin Signal
1 3V 6 5V
2 3 VIRS 7 Aux RTN
3 RTN Fan OFF
4 5V 5 Vaux
5 RTN 10 12V
Connector
1 23
(=)[=][=]0e)Ca)[=][=](e)Ca) =] [=](a)
[=](=)(&)[=][=](=) (=) [=][=](x)Ce) [«]
2 24
Pin Signal Pin Signal
1 +3.3V 7 aux RTN
2 +3.3V 8 Fan OFF
3 RTN 9 +5 V aux
4 +5V 10 +12V
5 RTN 11 3.3 Vaux
6 +5V 12 Fan CMD

Pin
11
12
13
14
15

Pin
13
14
15
16
17
18

Signal
3V

12V
RTN
ON/STBY
RTN

Signal
+3.3V
12V

RTN
ON/STBY
RTN

RTN / (R/S)

Pin
16
17
18
19
20

Pin
19
20
21
22
23
24

Signal
RTN/RS
RTN
-5V

5V

5V

Signal
RTN

5V
+5V
+5V
3.3VR/S
Fan Sink
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appendix B

POWER CORD SET REQUIREMENTS

The voltage select switch feature on the computer permitsit to operate from any line voltage
between 100-120 or 220-240 volts AC.

The power cord set received with the computer meets the requirements for use in the country
where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you
use the computer. For more information on power cord set requirements, contact your authorized
Compaq dealer, reseller, or service provider.

General Requirements

The requirements listed below are applicable to al countries:

1. Thelength of the power cord set must be at least 6.00 feet (1.8 m) and a maximum of 9.75 feet
(3.0m).

2. All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal voltage rating
of 125 or 250 volts AC, as required by each country’ s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector, for mating with appliance inlet on the Switch Box.
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Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) JIS

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) UL

Germany (1) VDE

Notes:

(1) The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm? conductor size. Power
cord set fittings (appliance coupler and wall plug) must bear the certification mark of the agency
responsible for evaluation in the country where it will be used.

(2) The flexible cord must be Type SJT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be
a two-pole grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A 250V) configuration.

(3) The appliance coupler, flexible cord, and wall plug must bear a "T" mark and registration number in
accordance with the Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor,
0.75 mm? conductor size. The wall plug must be a two-pole grounding type with a Japanese Industrial
Standard C8303 (15A, 125V) configuration.
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appendix C

HARD DRIVES

Device 0/Device 1 Relationship

SMART

A device O/device 1 relationship exists when there are two hard drives connected to a single port.
In this situation, one drive must be designated as the device 0, and the other as the device 1 by the
proper use of the drive jumpers. This designation is necessary because both drives cannot work
simultaneously.

When the computer supports cable-select, the device O/device 1 designations are determined by
each drive's connector location on the data cable. Device 0 is attached to the data cable connector
at the farthest distance from the system board while device 1 is attached to the connector closest
to the system board. When only asingle drive is used, the drive should be connected to the device
0 connector. The user must set each drive's jumpers to the cable-select setting for the computer to
properly set the drive designation.

The SMART IDE and SCSI hard drives for the Compag Deskpro Personal Computers and
Workstations have built-in drive failure prediction that warns the user or the network
administrator of an impending failure or crash of the hard drive. The SMART drives track fault
prediction and failure indication parameters such as re-allocated sector count, spin retry count,
and calibration retry count. If the drive determines that afailureisimminent, it generates a fault
alert.

Device Cabling

Newer, Ultra ATA-66 (Ultra DMA-66) drives require 40-pin, 80-conductor cables to maintain the
higher data transfer rates possible with the improved technology. The computer system must
support Ultra ATA-66 logic for it to take advantage of the higher data transfer rates.

When using both Ultra ATA-66 and slower Ultra ATA-33 drives in the same system, the drives
will operate at their respective data transfer rates.

Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of adrive partition. A drive partition is the largest segment of a drive that
may be properly accessed by the operating system. A single hard drive may therefore be
subdivided into a number of unique drive partition in order to make use of all of its space.

The table that follows identifies the capabilities and restrictions imposed on the computer by the
combinations of file and operating systems.
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Drive Partition Size

File System Operating System Maximum Partition Size
FAT 16 DOS/Windows 95 2GB

FAT 16 Windows NT 4 GB

FAT 32 2 Terabytes

NTFS 2 Terabytes

For example, an 8-GB drive operating in a Windows 95 environment using FAT 16 would have a
total of four 2-GB drive partitions. That same drive operating in Windows NT using FAT 16
would have two 4-GB drive partitions unless the user elected to subdivide it into smaller sections.
Theidentical drive using FAT 32 would have a single 8-GB partition unless the user elected to
subdivide it into smaller sections.

c-2 Hard Drives



appendix D

POST ERROR MESSAGES

An error message results if the Power-On Self-Test (POST) encounters a problem. This test runs
when the system is turned on, checking assemblies within the computer and reporting any errors
found.

Screen Message Beeps* Probable Cause Recommended Action

101-Option ROM Error 1L, 1S System ROM checksum. 1. Verify the correct ROM.
2. Flash the ROM if needed.

3. If an expansion card was
recently added, remove it and
see if the problem remains.

4. Clear CMOS.

5. If the message disappears,
there may be a problem with the
expansion card.

6. Replace the system board.

102-System Board None DMA, timers, etc. 1. Clear CMOS.
Failure 2. Remove expansion boards.

3. Replace the system board.

103-System Board Failure None DMA, timers, etc. 1. Clear CMOS.
2. Remove expansion boards.

3. Replace the system board.

150-SafePost Active None A PCl expansion card is not 1. Restart the computer.
responding. 2. Disable SafePost.

3. If the expansion card does not
respond, replace the card.

162-System Options 2S Configuration incorrect. Run Computer Setup (F10 Setup)

Not Set RTC (real-time clock) Set the date and time under Control
battery may need to be Panel or in F10 Setup depending
replaced. Battery life is on the operating system.

approximately 3 years. If the problem persists, replace the

RTC battery.

*L =Long, S = Short Continued
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POST Error Messages Continued
Screen Message

163-Time & Date Not Set 2S

164-Memory Size Error 2S

183-Invalid Processor Jumper 2S
Setting

201-Memory Error None

202-Memory Type Mismatch None

*L =Long, S = Short

Beeps*

Probable Cause

Invalid time or date in
configuration memory.

RTC (real-time clock)
battery may need to be
replaced. Battery life is

approximately five years.

CMOS jumper may not
be properly installed.

Memory configuration
is incorrect.

System board jumper
improperly set.

RAM failure.

Memory modules do not
match each other.

Recommended Action

Set the date and time under Control
Panel or in F10 Setup depending
on the operating system.

If the problem persists, replace the
RTC battery.

Check for proper placement of the
CMOS jumper.

1. Run Computer Setup (F10
Setup) or Windows utilities.

2. Make sure memory module(s)
(if any) are installed properly.

3. If third party memory has been
added, test using Compag-only
memory.

4. Verify proper memory module
type.

Reset system board jumpers to
match processor and bus speeds.

1. Run computer Setup (F10
Setup) or Windows utilities.

2. Ensure memory and continuity
modules are installed correctly.

3. Verify proper memory module
type.
4. Remove and replace memory

module(s) one at a time to
isolate faulty module.

5. Replace the faulty memory
module(s).

6. If error persists after replacing
memory modules, replace the
system board.

Replace memory modules with
matched sets.

Continued
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POST Error Messages Continued

Screen Message

207-ECC Corrected Single Bit 2S
Errors in Memory Socket(s)

Y,y

Beeps*

212-Failed Processor None

213-Incompatible memory 2S
Module in memory Socket(s)
XX, X

214-Memory Device Failure. None
Error Code: XX Memory

Module Socket(s):XX

301-Keyboard Error None

304-Keyboard or System Unit None
Error

401-Parallel Port 1 Address  2S
Assignment Conflict

*L =Long, S = Short

Probable Cause
Single Bit ECC error.

Processor has failed to
initialize.

A memory module in memory
socket identified in the error
message is missing critical
SPD information, or is
incompatible with the chipset.

A specific error has occurred
in a RDRAM device installed
in the identified socket.

Keyboard failure.

Keyboard failure.

IRQ address conflicts with
another device.

Recommended Action

1. Verify proper memory module
type.

2. Try another memory socket.

3. Replace memory module if
problem persists.

1. Reseat the processor in its
socket.

2. If the processor does not
respond, replace it.

1. Verify proper memory module
type.
Try another memory socket.

w N

Replace memory with a module
conforming to the SPD
standard.

1. Verify proper memory module
type.
2. Try another memory socket.

3. Replace memory module if
problem persists.

1. Reconnect keyboard with
computer turned off.

2. Check connector for bent or
missing pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

1. Reconnect the keyboard with
computer turned off.

2. Ensure that none of the keys are
depressed.

3. Replace keyboard.
4. Replace system board.

Reset the IRQ.

Continued
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POST Error Messages Continued
Screen Message Beeps*

403-Parallel Port 3 Address  2S
Assignment Conflict

404-Parallel Port Address 2S
Conflict Detected

410-Audio Interrupt Conflict 2S

411-Network Interface Card 2S
Interrupt Conflict

501-Display Adapter Failure 1L, 2S
601-Diskette Controller Error None
602-Diskette Boot Record None

Error

605-Diskette Drive Type Error 2S

*L =Long, S = Short

Probable Cause

IRQ address conflicts with
another device.

Both external and internal

ports are assigned to parallel

port X.

IRQ address conflicts with
another device.

IRQ address conflicts with
another device.

Graphics display controller.

Diskette controller circuitry
or floppy drive circuitry
incorrect.

Diskette in drive A not
bootable.

Mismatch in drive type.

Recommended Action
Reset the IRQ.

Remove any parallel expansion
cards.

2. Clear CMOS.

3. Reconfigure card resources

and/or run Computer Setup (F10
Setup).

Reset the IRQ.

Reset the IRQ.

. Reseat the graphics card (if

applicable).
Clear CMOS.

3. Verify the monitor is attached

o bk~ w N

and turned on.

Replace the graphics controller.

. Run Computer Setup (F10

Setup).

Check and/or replace cables.
Clear CMOS.

Replace diskette drive.

Replace the system board.

Replace the diskette.

. Run Computer Setup (F10

Setup) or Windows NT,
Windows 95, or Windows 98
utilities.

Disconnect any other diskette
controller devices (tape drives).

Clear CMOS.

Continued
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POST Error Messages Continued

Screen Message

610-External Storage
Device Failure

611-Primary Floppy Port
Address Assignment Conflict

612-Secondary Floppy Port
Address Assignment Conflict

660-Display Cache is
Detected Unreliable

912-Computer Cover Has
Been Removed Since Last
System Start Up

914-Hood Lock Coil is not
Connected

916-Thermal Sensor from
Processor Heatsink is not
Connected.

917-Expansion Riser not
Detected

1151-Serial Port 1 Address
Conflict Detected

*L =Long, S = Short

Beeps*

None

None

None

None

None

None

28

Probable Cause

External tape drive not
connected.

Configuration error.

Configuration error.

Integrated video controller
display cache not working
properly and will be disabled.

Hood lock mechanism is
missing or not connected.

Processor Heatsink cable not
connected to system board.

Riser board not seated or not
installed.

Both external and internal
serial ports are assigned to
COM1.

Recommended Action

Reinstall tape drive or press F1 and
allow system to reconfigure without
the drive.

1. Run Computer Setup (F10
Setup).

2. Remove expansion cards.
3. Clear CMOS.

1. Run Computer Setup (F10
Setup).

2. Remove expansion cards
3. Clear CMOS.

Replace system board if minimal
video degrading is an issue.

No action required.

1. Reconnect or replace hood
locking mechanism.

2. Reseat or replace hood locking
mechanism cable.

Reseat or replace the Processor
Heatsink cable going to the system
board.

Install riser board if missing or
remove and reseat to ensure good
connection.

1. Remove any Comm port
expansion cards.

2. Clear CMOS.

3. Reconfigure card resources
and/or run Computer Setup (F10
Setup).Run Computer Setup or
Windows utilities.

Continued
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POST Error Messages Continued
Screen Message

1152-Serial Port 2 Address  2S
Conflict Detected

Beeps*

1155- Serial Port Address 2S
Conflict Detected

1201-System Audio Address 2S
Conflict Detected

1202-MIDI Port Address 2S
Conflict Detected

1203-Game Port Address
Conflict Detected

1611- Fan failure detected None
1720-SMART Hard Drive None
Detects Imminent Failure

1721-SMART SCSI Hard None

Drive Detects Imminent
Failure

*L =Long, S = Short

Probable Cause

Both external and internal
serial ports are assigned to
COM2.

Both external and internal
serial ports are assigned to
same IRQ.

Device IRQ address conflicts
with another device.

Device IRQ address conflicts
with another device.

Device IRQ address conflicts
with another device.

Chassis fan not connected to
the system board.

Hard drive is about to fail.
(Some hard drives have a
firmware patch that will fix an
erroneous error message.)

Hard drive is about to fail.
(Some hard drives have a
firmware patch that will fix an
erroneous error message.)

Recommended Action

1. Remove any Comm port
expansion cards.

2. Clear CMOS.

3. Reconfigure card resources
and/or run Computer Setup (F10
Setup).Run Computer Setup or
Windows utilities.

1. Remove any Comm port
expansion cards.
2. Clear CMOS.

3. Reconfigure card resources
and/or run Computer Setup (F10
Setup).Run Computer Setup or
Windows utilities.

Reset the IRQ.

Reset the IRQ.

Reset the IRQ.

Reconnect the fan.

Replace the fan.

w N -

Replace the system board.

1. Determine if hard drive is giving
correct error message. Run the
Drive Protection System test
available.

2. Apply firmware patch if
applicable. (See www.
compaq.com\support\
techpubs\customer_advisories)

3. Back up contents and replace
hard drive.

1. Determine if hard drive is giving
correct error message. Run the
Drive Protection System test
available.

2. Apply firmware patch if
applicable.

3. Back up contents and replace
hard drive.

Continued
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POST Error Messages Continued

Screen Message Beeps* Probable Cause Recommended Action
1771-Primary Disk Port 2S Internal and external hard 1. Remove any disk controller
Address Assignment Conflict drive controllers are both expansion cards.

assigned to the primary 2. Clear CMOS

address. ’ '

3. Reconfigure card resources
and/or run Computer Setup (F10
Setup).

1772-Secondary Disk Port 28 Internal and external hard 1. Remove any disk controller
Address Assignment Conflict drive controllers are both expansion cards.

assigned to the primary 2. Clear CMOS
address. ' '
3. Reconfigure card resources

and/or run Computer Setup (F10
Setup).

1780-Disk 0 Failure None Hard drive/format error. 1. Run Computer Setup (F10
Setup).

Clear CMOS.
Check cables/jumper settings.
Run hard drive diagnostics.

Disconnect additional drives.

o gk~ w DD

Run the Drive Protection
System test if available.

7. Replace the hard drive.

1781-Disk 1 Failure None Hard drive/format error. 1. Run Computer Setup (F10
Setup).

2. Clear CMOS.

3. Check cable seating/jumper
settings.

4. Run hard drive diagnostics.
5. Disconnect additional drives.

6. Run the Drive Protection
System test if available.

7. Replace the hard drive.

*L =Long, S = Short Continued
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POST Error Messages Continued
Screen Message

Beeps*

1782-Disk Controller Failure None

1790-Disk 0 Failure

*L =Long, S = Short

None

Probable Cause

Hard drive circuitry error.

Hard drive error or wrong
drive type.

Recommended Action

1.

Run Computer Setup (F10
Setup).

Clear CMOS.

3. Check cable seating /jumper

settings.

4. Run hard drive diagnostics.

5. Disconnect additional drives.

6. Run the Drive Protection

System test if available.

Check www.compag.com\
suport\techpubs\
customer_advisories for
possible changes when using
Windows NT4.0 Service Pack 4.

8. Replace the hard drive.

9. Replace the system board.

Run Computer Setup (F10
Setup).

Clear CMOS.

3. Check cable seating /jumper

settings.

4. Run hard drive diagnostics.

5. Disconnect additional drives.

Confirm drive is supported on
this computer (Large drive ROM
support.)

Run the Drive Protection
System test if available.

8. Replace the hard drive.

9. Replace the system board.

Continued
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POST Error Messages Continued

Screen Message
1791-Disk 1 Failure

1792-Secondary Disk
Controller Failure

1793-Secondary Controller

or Disk Failure

1800-Temperature Alert

1801-Microcode Patch Error

*L =Long, S = Short

Beeps*

None

None

None

None

None

Probable Cause

Hard drive error or wrong
drive type.

Hard drive circuitry error.

Hard drive circuitry error.

Internal temperature
exceeds specification.

Processor not supported by
ROM Bios.

Recommended Action

1.

Run Computer Setup (F10
Setup).

2. Clear CMOS.

3. Check cable seating /jumper

settings.

4. Run hard drive diagnostics.

5. Disconnect additional drives.

6. Confirm drive is supported on
this computer (Large drive ROM

support).

Run the Drive Protection
System test if available.

8. Replace the hard drive.

9. Replace the system board.

. Run Computer Setup (F10

Setup).

2. Clear CMOS.

3. Check cable seating /jumper

settings.

4. Run hard drive diagnostics.

5. Disconnect additional drives.

6. Run the Drive Protection

System test if available.

Replace the hard drive.

. Run Computer Setup (F10

Setup).

2. Clear CMOS.

3. Check cable seating /jumper

settings.

4. Run hard drive diagnostics.
5. Disconnect additional drives.

6. Run the Drive Protection

System test if available.

Replace the hard drive.

Check that computer air vents

are not blocked and cooling fan

is running.

Verify processor speed
selection.

Replace the processor.

Replace the system board.

Upgrade Bios to proper version.

Continued
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POST Error Messages Continued

Screen Message Beeps*
Audible 1L, 3S
Audible 2S

Fixed Disk Parameter Table 3L
or BIOS Error System Halted

Flashing Caps Lock LED on 1L, 2S
Keyboard

Flashing Num Lock LED on 1S, 2L
Keyboard

Flashing Power and Hard None

Drive Green LEDs

Flashing Scroll Lock LED on 2L, 1S
Keyboard

Green Power LED Blinks None
Once per Second

Green Power LED ON None
Invalid Electronic Serial None
Number

*L =Long, S = Short

Probable Cause

System ROM is bad;
system is running in

Failsafe Boot Block mode.

Power-on successful.

Configuration or hardware
failure.

Graphics controller not
present or incorrectly
initialized.

System memory not
present

Unseated riser board.

System board hardware
failure (prior to video)

Computer in normal Suspend

mode.

Computer on.

Electronic serial number has

become corrupted.

Recommended Action

Reflash the ROM using a ROMPaq
diskette. Refer to the “Failsafe Boot
Block ROM” section of the Software
Reference Guide.

None

Run Computer Setup and
Diagnostic Utilities.

1. Clear CMOS.

2. If graphics card has been
added, remove and reseat.

3. Reset the riser board.

1. Check memory module.

2. Remove and reseat memory
module.

3. See “Memory Problems” in
Appendix F.

1. Remove riser board.

2. Wipe connector with a dry,
clean cloth.

3. Reinstall riser board.

Replace system board.

None

None

1. Run Computer Setup (F10
Setup). If Setup already has
data in the field or will not allow
the serial number to be entered,
download and run SP5572.EXE
(SNZERO.EXE).

2. Run F10 Setup and try to enter
serial number under Security,
System ID, then save changes.

Continued
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POST Error Messages Continued

Screen Message

Num Lock LED on None
Keyboard

Red Power LED Blinks Every None
2 or More Seconds

Red Power LED Blinks Every None
Second

Red power LED ON None
(Resume = F1 KEY) None
XXOO0O0YZZ Parity Check None

*L =Long, S = Short

Beeps*

Probable Cause
Failed Boot Block.

Power supply overloaded.

System memory error.

Processor unseated.

As indicated to continue.

Parity RAM failure.

Recommended Action

Reflash the ROM using a ROMPaq
diskette.

1. Push in power button. LED
should be green.

2. Remove all AC power from
computer, wait 30 seconds, then
apply power.

3. Remove load from power supply
by removing options one at a
time until computer runs.

4. Check for damage to system
board.

5. Replace system board.

6. Replace power supply.

1. Check memory module.

2. Remove and reseat memory
module.

3. See the "Solving Memory
Problems" section of this guide.
Reseat processor in system board.

Press F1.

Run Computer Setup and
Diagnostic Utilities.
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appendix E

DIAGNOSTIC INDICATOR LIGHTS

[]  Allindicator lights are not available on all products.

LED
Power

Power

Power

Power
Power

Power

Power

Power

Power and Hard Drive

Num Lock
Caps Lock
Scroll Lock

Color
Green

Green

Green

None
Red
Red

Red
Red

Red

Green
Green

Green

LED Activity
On

1 blink/second

1 blink/second

4 blinks/second
On

1 blink/second

1 blink/2 or more
seconds

On

Flashing
Flashing
Flashing

State/Message
Computer on

Normal suspend mode
Suspend to RAM

Computer off
CPU thermal shutdown
CPU not installed/fetching code

ROM error

Power supply overloaded

Riser board not seated

Memory error
No video

System board failure, prior to video
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appendix I:

TROUBLESHOOTING WITHOUT DIAGNOSTICS

Preliminary Checklist

This section describes some ssimple, preliminary tests and guidelines for troubleshooting the
computer without using the diagnostics.

If you encounter some minor problem with the computer or a software application, go through the

following checklist for possible solutions before running any of the diagnostic utilities:

Are the computer and monitor connected to aworking electrical outlet?
Isthe computer turned on?

Isthe green power light illuminated?

I's the monitor turned on?

Is the green monitor light illuminated?

Turn up the monitor brightness and contrast controlsif the monitor isdim.

Press and hold any key. If the system beeps, then the keyboard should be operating
correctly.

Check all cables for loose or incorrect connections.

Reconfigure the computer after installing a non Plug and Play expansion board or other
option, such as a diskette drive.

Areal of the necessary device driversinstalled?

Have all printer drivers been installed for each application?

Remove al diskettes from the diskette drives before you turn on the system.
Areal switches set correctly?

Isthe NIC Remote Wakeup cable (featured on some models) connected between the NIC
and the riser/system board?

Are al memory sockets filled on computers using RIMMSs?

Ensure that memory module types are not mixed on the same system board. The system
will not boot if RIMMs and DIMMs are mixed.
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Solving Minor Problems

Problem
Computer will not turn on.

Computer appears locked
up and won't turn off when

the power button is pressed.

Computer date and time
display is incorrect.

Computer powered off
automatically.

Insufficient power to the
components.

Computer appears to pause
periodically.

Cannot remove computer
cover or side panel.

Computer does not boot up
and power and hard drive
LEDs are blinking.

Computer does not boot up

and Num Lock LED is blinking; you
may hear one short and two long

beeps.

Possible Solution

1. Ensure that the computer is properly connected to an external power
source and the wall outlet is active.

2. A PCl or ISA card that has been installed is defective. Remove any
expansion card that was just installed.

3. Reseat drive power, data, and power supply cables.

4. Disconnect all drive cables and reboot. Add devices back one at a
time to isolate problem/

Software control of the power button may not be functional. Press and
hold the button for four seconds, then release. This invokes the
hardware override for the power button.

First, reset the date and time under Control Panel. If the problem
persists, the real-time clock (RTC) battery may need to be replaced.
Refer to the "Removal and Replacement Procedures” chapter in the
product-specific MSG.

When booting from a network, the PC clock may be reset to that of the
server. The PC clock may also change when using other services
through the server.

1. The unit temperature was exceeded because the unit is in an
exceedingly hot environment or the fan is blocked. Let the unit cool
down.

2. The fan may not be functioning correctly or the air vents are
blocked.

3. The unit temperature was exceeded because the computer was
functioning with the cover or side panel removed. Replace cover or
side panel, and let the computer cool down before turning power
back on.

Ensure that both power supply cables are connected to the system
board (on some workstations).

Network driver is loaded and no network connection is established.
Establish a network connection, or use Computer Setup or Windows
Device Manager to disable the network controller.

1. Smart Lock, featured on some computers, is locked. Unlock the
Smart Cover Lock using Computer Setup.

2. The Smart Cover FailSafe Key, a device for manually disabling the
Smart Cover Lock, is available from Compaq. You'll need the
FailSafe Key in cases of forgotten password, power loss, or
computer malfunction.

Ensure that the riser board is properly seated .

Memory may be improperly installed or may be bad.

Continued

Troubleshooting Without Diagnostics



Solving Minor Problems Continued

The Caps Lock LED is flashing; you
may hear one long and two short
beeps.

Computer does not boot up and the

Scroll Lock LED is flashing; you may

hear two long and one short beeps.

The video controller is not present or is incorrectly initialized. Clear
configuration memory (CMOS). If a video card has been added,
remove and reseat it.

System board hardware failure (prior to video). Replace system
board.

[] If the standard keyboard has been replaced with a Universal Serial Bus (USB)
keyboard, you will hear the beep sequences mentioned above but will not see the

flashing lights.
Diskette Drive

Problem
Diskette drive light stays on.

Diskette drive cannot write to
a diskette.

Cannot format diskette.

Diskette drive cannot read a
diskette.

Possible Solution

1.

AR

Diskette is damaged. In Windows 95 or 98, run ScanDisk. Click Start
- Programs > Accessories - System Tools > ScanDisk.

In Windows NT, right click Start, click Explore, and select a drive.
Select File > Properties - Tools. Under Error-checking, click
Check Now.

Diskette is incorrectly inserted. Remove the diskette and reinsert.
Software program may be damaged. Check the program diskettes.
Drive button is not pushed in. Push in drive button.

Drive cable is not properly connected. Reconnect drive cable.

Diskette is not formatted. Format the diskette.

. Diskette is write-protected. Either use another diskette that is not

write-protected or disable the write protection on the diskette.

. Writing to the wrong drive. Check the drive letter in the path

statement.

Not enough space is left on the diskette. Use another diskette.

5. Diskette write control is enabled. Check the Removable Media write

settings in Computer Setup.

Invalid media reported. When formatting a diskette in DOS, you may
need to specify diskette capacity. For example, to format a 1.44-MB
diskette, type the following command at the DOS prompt:

FORMAT A:/F:1440

1.
2.

Diskette is not formatted. Format the diskette.

Using the wrong diskette type for the drive type. Check the drive
type and use a compatible diskette.

. Reading the wrong drive. Check the drive letter in the path

statement.

Diskette drive has been disabled by Computer Setup, Windows NT,
Windows 95, or Windows 98 utilities. Run Computer Setup and
enable the diskette drive.

Continued
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Diskette Drive Continued

A problem has occurred with
a disk transaction.

Non-system disk message.

Drive not found.

System has misidentified the
diskette drive type.

The directory structure is bad, or there is a problem with a file. In
Windows 95 or 98, run ScanDisk. Click Start - Programs >
Accessories > System Tools - ScanDisk.

In Windows NT, right click Start, click Explore, and select a drive.
Select File > Properties = Tools. Under Error-checking, click Check
Now.

The system is trying to start from a nonsystem diskette. Remove the
diskette from the drive.

1. Reseat the diskette drive cable.

2. If a second diskette drive has been installed, follow the computer
reconfiguration directions in the "Hardware Installation Problems”
section.

If a diskette drive other than a 3.5-inch, 1.44-MB drive has been
installed, ensure that the drive type is identified correctly under
Computer Setup.

Display
Problem Possible Solution
Screen is blank 1. Monitor is not turned on and the monitor light is not on. Turn on the
monitor and check that the monitor light is on.

2. Screen save has been initiated. Press any key or move the mouse
to light the screen.

3. The cable connections are not correct. Check the cable connection
from the monitor to the computer and to the electrical outlet.

4. The brightness need adjusting. Adjust the brightness control.

5. The energy saver feature has been enabled. Press any key or click
the mouse button and, if one has been set, type the password.

6. The RGB (Red, Green, Blue) input switch on the back of the monitor
is incorrectly set. Set the monitor's input switch to 75 ohms and, if
there is a sync switch, set it to External.

7. System ROM is bad and system is running in FailSafe Boot Block
mode (indicated by one long beep and three short beeps). Reflash
the ROM using a ROMPaq diskette. Refer to "FailSafe Boot Block
ROM" in section 3.4.1 of this book.

8. If a fixed-sync monitor is used, be sure that the monitor can accept
the same sweep rate as the resolution chosen.

9. Ensure the VGA/BNC selector is properly set.

Graphics colors are wrong. Either the cabling or the monitor impedance is incorrect.

1. Ensure that the Red, Green, and Blue BNC cables are connected to
the corresponding monitor connectors.

2. Be sure the monitor's RGB inputs are set to 75 ohms.

Continued
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SCSI

Display Continued

Characters are dim.

Monitor does not function
properly when used with the
energy saver features.
Blurry display or requested
resolution cannot be set.

The picture is broken up; it rolls,
jitters, or blinks.

Screen goes blank.

Monitor overheats.

Cursor will not move using the
arrow keys on the numeric
keypad.

Problem

System with IDE and SCSI drives

will not boot from SCSI hard
drive.

System will not boot from a
SCSl drive.

1. Adjust the monitor's brightness and contrast controls.

2. Check that the video cable is securely connected to the graphics
card and monitor.

3. Set the RGB switch (and sync options, if available) to 75 ohms, with
the sync set to External. Refer to the documentation included with
the monitor.

Monitor without the energy saver feature is being used with energy
saver features enabled. Disable the monitor energy saver features.

If the graphics controller was upgraded, the correct display drivers
may not be loaded. Install the correct display drivers on the diskette
included in the upgrade Kit.

1. Be sure the monitor cable is securely connected to the computer.

2. In a two-monitor system or if another monitor is in close proximity,
move the monitors apart to be sure they are not interfering with one
other's magnetic field.

3. Fluorescent lights or fans may be too close to the monitor.

A screen blanking utility may be installed or energy saver features
may be enabled. Press any key or type password.

There is not enough ventilation space for proper airflow. Leave at least
3inches (7.6 cm) of ventilation space. Be sure there is nothing on top
of the monitor obstructing the air flow.

The Num Lock key is on. Press the key to turn it off. The Num Lock
light should not be on when you want to use the arrow keys.

Possible Solution

The IDE drive needs to be disabled. Under the Computer Setup
Advanced menu, disable the primary IDE controller.

1. The SCSI drive is not configured correctly.

2. Ensure that drive cabling and jumpers are set correctly. To boot a
SCSI drive, the drive ID number must be set to 0.
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Printer

Problem
Printer will not print.

Printer will not turn on.

Prints garbled information.

Printer is offline.

Possible Solution

1. Printer is not turned on and online. Turn the printer on and ensure it
is online.

2. Run printer self-test.
3. Reseat both ends of the printer cable.

4. Verify that printer port is enabled in BIOS and in Windows using F10
Setup.

5. Try printing using the DOS command
C:\ [printer port].
Where [printer port] is the port address to which the printer is
connected.
If printer works, problem is with the printer driver. Reload driver.

6. If the computer is on a network, you may not have made the
connection to the printer. Make the proper network connections to
the printer.

The cables may not be connected properly. Reconnect all cables and
check the power cord and electrical outlet.

1. The correct printer drivers for the application are not installed. Install
the correct printer driver for the application.

2. The cables may not be connected properly. Reconnect all cables.

The printer may be out of paper. Check the paper tray and refill it if
empty. Select online.
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Hard Drive

The information provided by the diagnostics testsincludes:. error code, system serial number,
drive serial number, drive model, and drive firmware revision. Specific details of the drive failure

are not included.

When you run the diagnostics, the test results are stored in alog. After completing the test, you
can print thislog to aloca printer or saveit to afile. Alternatively, before running the test, you
can configure the test options to send the resultsto alocal printer or file.

Problem
Hard drive error occurs.

Disk transaction problem.

Drive not found (identified).

Nonsystem disk message.

Second Ultra ATA hard drive does
not perform optimally.

Possible Solution

Hard disk has bad sectors or has failed. Use a utility to locate and
block usage of bad sectors. If necessary, reformat the hard disk.

Either the directory structure is bad or there is a problem with a file. In
Windows 95 and 98, run ScanDisk. Click Start - Programs -
Accessories > System Tools - ScanDisk.

In Windows NT, right click Start, click Explore, and select a drive.
Select File > Properties - Tools. Under Error-checking, click Check
Now.

1. Cable could be loose. Check cable connections.

2. The system may not have automatically recognized a newly
installed device. See reconfiguration directions in the "Hardware
Installation Problems” section. If system still does not recognize the
new device, check to see if the device is listed within Computer
Setup. If it is listed, the probable cause is a driver problem. If it is not
listed, the probable cause is a hardware problem.

3. Check drive jumper settings. If the drive is a secondary drive that
has just been installed on the same controller as the primary drive,
verify that the jumpers for both drives are set correctly.

4. Check SCSI IDs to ensure none are duplicated.

1. The system is trying to start from a diskette that is not bootable.
Remove the diskette from the diskette drive.

2. The system is trying to start from the hard drive but the hard drive
may have been damaged. Insert a bootable diskette into the diskette
drive and restart the computer.

3. Diskette boot has been disabled in Computer Setup. Run Computer
Setup and enable diskette boot.

The cable is not compatible with the drive type. Reinstall the second
Ultra ATA hard drive using an 80-conductor cable.
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Hardware Installation

Y ou may need to reconfigure the computer when you add or remove hardware, such as an additional
diskette drive. If you install a Plug and Play device, Windows 95 and 98 in most cases will
automatically recognize the device and configures the computer. If athird-party Plug and Play
deviceis not recognized, contact the device manufacturer. If you install a non-Plug and Play device,
you must reconfigure the computer after completing installation of the new hardware. In Windows
95 and 98, select the Add New Hardware icon in the Control Panel and follow the instructions that
appear on the screen. To reconfigure the computer in Windows NT Workstation 4.0 after installing
new hardware, use the utility provided with the hardware.

Problem Possible Solutions

A new device is not 1. The computer needs to be reconfigured to recognize the new

automatically recognized as device. Follow the reconfiguration instructions above. If system still

part of the computer system. does not recognize the new device, but the device is listed within
Computer Setup, use Computer Setup to address any resource
conflicts.

2. When the system advised you of changes to the configuration, you
did not accept them. Reboot the computer and follow the
instructions for accepting the changes.

3. A Plug and Play board may not automatically configure when added
if the default configuration conflicts with other devices. Use Windows
95 or 98 Device Manager to deselect the automatic settings for the
board and choose a basic configuration that doesn't cause a
resource conflict. You can also use Computer Setup to reconfigure
or disable devices to resolve the resource conflict.

4. The cables for the new external device are loose or the power
cables are unplugged. Check all cables, and check that pins in the
cable or connector are not bent down.

5. The power switch for the new external device is not turned on. Turn
off the computer, turn on the external device, and then turn the
computer on to integrate the new device with the computer.

6. If the drive is a secondary drive that has just been installed on the
same controller as the primary drive, verify that the jumpers for both
drives are set correctly.

Insufficient power to the Ensure both power supply cables are connected to the system board.
components. (some Workstations)

Installed third-party SCSI hard The third-part adapter is either not supporting BIOS Boot Specification
drive adapter not participating or the Boot Vector option. A solution is not available.

in the hard drive ordering sequence

provided in F10 Setup and/or is

always coming up as the boot

device regardless of the

predetermined sequence.
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DVD- and CD-ROM

Problem
Cannot read compact disc.

System will not boot from
CD-ROM or DVD drive.

Cannot eject compact disc
(tray-load unit).

Cannot eject compact disc
(slot-load unit).

CD-ROM or DVD device is not
detected; driver is not loaded.

Movie will not play in the DVD
drive.

Possible Solution

1.

CD is not properly seated in the drive. Eject the CD, correctly seat it
in the drive, then reload.

. CD has been loaded upside down. Eject the CD, turn it over, then

reload.

. The CD-ROM or DVD boot is not enabled through the Computer

Setup utility. Run the Computer Setup utility and set the drive
priorities.

. Ensure that drive cabling and jumpers are set correctly. To boot a

SCSI drive, the drive ID number must be set to 0.

CD is not properly seated in the drive. Turn off the computer and insert
a thin metal rod into the emergency eject hole and push firmly (a
straightened paper clip can be used). Slowly pull the tray out from the
drive until the tray is fully extended, then remove the CD.

> w o=

Remove the drive from the chassis.

Remove the front bezel from the drive.

Remove the top and bottom drive covers.

Release the clamping mechanism to retrieve the CD.

CD-ROM or DVD drive is not connected properly or not properly
terminated. Open the computer and check the drive cable.

Movie may be regionalized for a different country. Refer to the
documentation that came with the device.
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Memory

Problem

System won't boot or does not
function properly after installing
additional memory modules

Out of Memory error.

Memory count during POST is
wrong.

Insufficient memory error during
operation.

Unit is on but there is no video and
the power LED is blinking red.

Possible Solution

Memory module is not the correct type or speed grade for the system.
Replace module with the correct industry-standard device for the
computer.

1. Memory configuration may not be set up correctly; check memory
configuration using Device Manager.

2. The computer has run out of memory for the application. Check the
application documentation to determine the memory requirements.

Memory modules may not have been installed correctly or incorrect
modules may have been used.

1. Too many Terminate and Stay Resident programs (TSRs) are
installed. Delete any unnecessary TSRs.

2. There is not enough memory for the application. Check the memory
requirements for the application or add more memory.

Memory is not installed correctly and system is not booting. Reinstall
memory modules.

F-10
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Network

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging network cabling.

Problem

The Remote Wakeup feature is
not functioning.

Network driver does not detect
network controller.

Network status link light does not
turn on or flashes.

Diagnostics reports a failure.

Diagnostics passes, but the
computer does not communicate
with the network.

Possible Solution

1.

2.

The feature is not available when using an AUI network connection;
use an RJ-45 network connection.

Remote Wakeup is not enabled. Use the network control application
to enable Remote Wakeup.

Network controller is disabled. Run Computer Setup and enable
network controller.

. No active network is detected. Check cabling and network

equipment for proper connection.

. Network connection is not set up properly. Use the network control

application to verify that the device is working properly.

. System is configured for AUI connection; link LED does not apply to

AUI connections.
Network driver is not properly loaded. Reinstall network drivers.

5. System cannot autosense the network. Disable autosensing

capabilities and force the system into the correct operating mode.

Refer to www.compag.com\support\files for the latest version of
diagnostics.

1.

The cable is not securely connected or is attached incorrectly.
Ensure that the cable is securely attached to the network connector
and that the other end of the cable is securely attached to the
correct device.

. There is a problem with the cable or a device at the other end of the

cable. Ensure that the cable and device at the other end are
operating correctly.

. The network controller is defective. Replace the controller or the

system board.

. Network controller interrupt is shared with an expansion board.

Under the Computer Setup Advanced menu, change the resource
settings for the board.

. Network drivers are not loaded, or driver parameters do not match

current configuration. Make sure the network drivers are loaded and
the driver parameters match the configuration of the network
controller.

. The network controller is not configured for this computer. In

Windows 95, 98, or Windows NT, select the Network icon at the
Control Panel.

. Network controller interrupt with an expansion board. Under the

Computer Setup Advanced menu, change the resource settings for
the board.

Continued
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Network Problem Continued
Problem

Network controller stopped
working when an expansion
board was added to the
computer.

Network controller stopped

working without apparent cause.

Cannot connect to the network
server when attempting Remote
System Installation.

System Setup utility reports
unprogrammed EPROM.

Possible Solution

1.

Network drivers are not loaded or driver parameters do not match
the current configuration. Make sure that the drivers are loaded and
that the driver parameters match the configuration of the network
controller.

The cable is not securely connected or is attached incorrectly.
Ensure that the cable is securely attached to the network connector
and that the other end of the cable is securely attached to the
correct device.

Network controller interrupt is shared with an expansion board.
Under the Computer Setup Advanced menu, change the resource
settings for the board.

Network drivers were accidentally deleted when the drivers for the
new expansion board were installed, or the files containing the
network drivers are corrupted. Reinstall the network drivers, using
backup diskettes.

. The files containing the network drivers are corrupted. Reinstall the

network drivers, using backup diskettes or the Compaq Restore CD.

The cable is not securely connected or is attached incorrectly.
Ensure that the cable is securely attached to the network connector
and that the other end of the cable is securely attached to the
correct device.

The network controller is defective. Replace the network controller
or system board.

The network controller is not configured properly. Run Computer
Setup and modify the Embedded NIC Settings.

. Boot the workstation without the network drivers using a system

boot diskette and reconfigure the controller.

Replace the controller.
Replace the system board.
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Troubleshooting Without Diagnostics



Resolving Audio Hardware Conflicts

Hardware conflicts occur when two or more peripheral devices contend for the same signal lines
or channels. Conflicts between the audio interface and another peripheral device may be dueto
the settings of the base 1/0 addresses, interrupts, or DMA channels. The audio interface typically
has the following settings:

Item Setting
Base 1/0 address 220H

FM Synthesizer I/O address 388-38Bh
Interrupt IRQ 5
8-bit DMA Channel 1

To resolve hardware conflicts:

1. Change the hardware settings of your audio card or the peripheral card in your system if the
peripheral card is using the audio interface setting. Y ou can change settings for integrated
audio using Computer Setup.

2. If you are unsure of the settings of the peripheral cards, you can isolate the source of the
problem by temporarily removing all cards and other essential cards such as the disk controller.
After that, add the cards back one at atime until the card that is causing the conflict is found.

Problem Possible Solution
Sound does not come out of  Software volume control is turned down electronically, or CD-ROM
the speaker. volume control on the front or back of the computer is turned down.

Double click on the speaker icon located on the taskbar, then set the
volume by adjusting the volume slider.

Troubleshooting Using Compagq Intelligent Manageability Features

The Local Alert Pop-Up Diaog notifies you of an impending or actual hardware failure. If the
computer is connected to a network and the Compag Insight Management Agents are installed
and configured, an Simple Network Management Protocol (SNMP) trap (message) is sent to the
specified SNMP-compliant management application.

The Local Alert Pop-Up Dialog also tells you the steps you need to take prior to a hardware
failureto avoid loss of data and damage to the computer. The system administrator can create a
customized action message that might include contact telephone or pager numbers.

To closethe Local Alert Pop-Up Dialog, click the Close button. To retrieve fault information
after closing the dialog, run Compag Insight Personal Edition.

For more detailed information, refer to the online Intelligent Manageability Guide.
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appendix G

SYSTEM BOARD AND RISER BOARD REFERENCE

DESIGNATORS

Designator
E49

ES50
E51

J6

J7

J8
J10-19
J20 -29
J30
J31-J35
J36

J40

J50

J51

J52

J66
J67
J68

J69
J70
J71

J72
J73
J74
J75
J76

Component
Clear Password header

CMOS header

Video pass through header
BNC

RJ-45 Jack

IEEE 1394

ISA slots

PCI slots

Riser board socket
Device bay connectors
AC97 connector

AGP slot

First parallel port
Second parallel port

Double-stacked parallel port
Top Port B
Bottom Port A

Keyboard connector (Closest to monitor connector)
Mouse connector

Double-stacked mouse/keyboard connector
Top Mouse
Bottom Keyboard

Video connector
Single USB connector

Double-stacked USB
Top Port 1
Bottom Port 2

Microphone jack
Line-in jack
Line-out jack
Headphone jack
Volume control

Continued
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Reference Designators Continued

Designator
J77

J78

J8o
J81

J82

P1
P2
P3
P5

P6
P7
P8
P9
P10
P11
P12
P15
P20
P21
P22
P25 - P26
P29
P30
P31
P53
P54
P55

P58
P70
P89

Component

Double-stacked headphone/microphone connector
Top Microphone
Bottom Headphone

Double-stacked line-in/line-out connector
Top Line in
Bottom Line out

Stacked serial/audio connetor

Primary double stack USB
Top Port 2
Bottom Port 1

Secondary double stack USB
Top Port 4
Bottom Port 3

P/S connector
Second P/S connector (as required)
Third P/S connector (as required)

Main Power switch and HDD and power LED connector (pins 1-9) and
SCSI LED connector (pins 10-11)

Speaker connector

Audio connector (from CD-ROM)
Chassis fan connector

WOL connector (NIC cable)
Diskette drive connector

Second Audio connector

Alert on LAN NIC connector

AUI connector

Primary IDE connector
Secondary IDE connector
Slimline CD-ROM connector
Video memory upgrade connector
SCSI LED connector

Primary SCSI connector
Secondary SCSI connector

First serial port

Second serial port

Double stack serial port
Top Serial B
Bottom Serial A

Riser edge connector (male-mates with J30)
Processor (CPU) fan header for fansink

Floating serial port /COM port header
Continued
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Reference Designators Continued

Designator
P100

P216

SWi1

Sw2

SW50

XBT1

XMM1

XMM2 - XMM5
XU1

Xu2

XU15

Component
ITP connector

White box chassis fan

Processor speed switch

Security hood switch

Clear CMOS switch

Battery socket

Memory slot. The first slot populated (DIMM1 or RIMM1) and tested.
Following memory slots

Primary processor socket

Secondary processor socket

ROM socket
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MODEL NUMBER NAMING FOR COMPAQ PRODUCTS

Compaq Deskpro Series of Personal Computers

ENC

Slash exists only when number

of characters permits use

/P933/10a 6/ 128cvmB

Product Processor Operating
Line Speed System
EN, EP, MHz 2 - Win 2000
EC, EX 4-Win NT 4.0
v v 5 - Win 95
Form Factor Hard Drive g:\z/\;: 98
blank, a, and C - Capacity, 9. 5+8
Convertible GB -
Minitower
D - Desktop h 4 h 4
L - Slim Desktop Chipset Memory,
M - Minitower blank - BX MB RAM
S - Small Form a-810
Factor b - 810e
c-815
\ 4 d-820
Processor Type e-815e
C - Celeron
P - Pentium
A 4
Removable Graphics Nic/Modem SMB Software
Storage blank - n-NIC B - Office 2000
blank - none integrated m - modem Small Business
b -c+r a - AIMM F - Office 2000
¢ - CD-ROM v - nVidia Professional
d-DVD P - Office 2000
r- CORW Premium
z-ZIP W - MS Word
S - Office 2000
Personal
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Compaq Professional Workstations

Processors 600 MHz and Lower

55/600EB/128R6/18L/3M

l

l

designations.

Processor speeds 650 MHz
and faster will not have letter

B - 133 MHz system bus
E - Advanced Transfer Cache

1st two Processor

d|g|tS Of Speed

product =/< 600 MHz

name

\ 4
Processor Type**
B -P I1I/133 MHz
E - P I11/100 MHz
EB -PIIl/133
X - Plll Xeon
blank - PI1I/100 MHz
Notes: **

Memory,
MB RAM
h 4
Memory Type
R - Rambus
S - SDRAM
h 4
Memory Speed
6 - 600 MHz \ 4
7 - 700 MHz
8 - 800 MHz Graphics
2 -2D
2+ -2D/3D
3M - Mid 3D
3E -Enh. 3D

Hard Drive Capacity
and Type

2X - multi 2 port
4X - multi 4 port
X - no graphics

18 - 18.0 GB

A -UATA

L - Ultra2 or Ultra3
SCSI (LVD drive)

S -SCsli
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Processors 650 MHz and Greater

55/1.0/256R8/18L/3M/N

l

1st two Processor '\SA g
digits of P
g Speed 6 - 600 MHz
product =/> 650 MHz 7 - 700 MHz
name
8 - 800 MHz
v A 4
Memory, Memory Type
MB RAM R - Rambus
S - SDRAM
Hard Drive Capacity
and Type
18 - 18.0 GB
Notes: ** A - UATA

Processor speeds 650 MHz
and faster will not have letter
designations.

B - 133 MHz system bus

E - Advanced Transfer Cache

L - Ultra2 or Ultra3
SCSI (LVD drive)
S -SCSli

Graphics

2

2+ -2D/3D

3M - Mid 3D

3E - Enh.3D
2X - multi 2 port
4X - multi 4 port

X

-2D

- no graphics

A 4
Operating System
N - Win NT 4.0
W - Win 2000
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DIAGNOSTIC ERROR CODES

Diagnostic error codes occur if the system recognizes a problem while running the Compag
Diagnostics program. These error codes help identify possibly defective subassemblies.

Diagnostic error messages consist of three components, AABB-CC, where
AA = Device Code
BB = Subtest Code
CC = Error Code

The following table lists the device codes (AABB-CC) and the subtest code (AABB-CC) covered

by Compag Diagnostics Tests. Some codes listed in this table will not apply to the computers
described in this manual and will not be detailed in the tables that follow.

Error Code
Range
0100 - 0199
0200 - 0210
0301 - 0304
0401 - 0498
0501 - 0516
0600 - 0699
0802 - 0824
1101 - 1109
1201 - 1210
1700 - 1799
1800 - 1823
1900 - 1906
2113 - 2199
2402 - 2480

2502 - 2502

Summary of Test Error Codes

Device Description
Processor (P1)

Memory

Keyboard

Parallel Port

Video Display Unit
Diskette Drive
Monochrome Video Card
Serial Port

Modem

Hard Drive

CD-ROM

Tape Drive

Second Processor (P2)

Enhanced Color Graphics
(ECG/VGA)

Pen/Digitizer

Error Code

Range

3113 -
3206 -
3300 -
3400 -
4113 -
5100 -
5234 -
6000 -
6500 -
6600 -
6700 -

7000
8601

8700 -

3199
3206
3333
3401
4199
5130
5240
6089
6599
6699
6799

8702

Device Description
Third Processor (P3)

Audio System

Mediavision Spectrum 16 Multimedia
TV Tuner Card

Fourth Processor

Plasma Display System
Advanced Color Graphics (AGC)
Network Card

SCSI Hard Drives

CD-ROM Drives

SCSI Tape Drives

Server Manager/R Card
Auxiliary Input Interface

Game Port
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The remaining tables list possible error codes (AABB-CC), descriptions of each error condition,
and recommended actions to resolve the error condition.

[] Retest the system after completing each step. If the problem has been resolved, do
not proceed with the remaining steps.

For assistance in the removal and replacement of a particular subassembly, see the “ Removal and
Replacement Procedures” chapter in the product-specific M SG.

Microprocessor
Error
Code Description
0101-xx CPU test failed.
0102-xx Coprocessor error.
0103-xx DMA controller failed.
0104-xx Interrupt controller failed.
0105-xx Port error.
0106-xx Keyboard controller self-test

failed.

0107-xx CMOS RAM test failed.
0108-xx CMOS interrupt test failed.
0109-xx CMOS clock test failed.
0110-xx Programmable timer test failed.
0113-01 Protected mode test failed.
0114-01 Speaker test failed.
0199-xx Installed devices test failed.

Recommended Action
The following steps apply to 0101-xx through 0102-xx:

1. Run Computer Checkup or Computer Setup and retest.
2. Replace processor and retest.
3. Replace the system board and retest.

The following step applies to 0103-xx through 0106-xx:

Replace the system board and retest.

The following steps apply to 0107-xx through 0109-xx:
1. Replace the battery/clock module and retest.
2. Replace the system board and retest.

Replace the system board and retest.
Replace the system board and retest.

1. Verify the speaker connection.
2. Replace speaker (if applicable) and retest.

3. Replace the system board and retest.

Check system configuration.
Verify cable connections.
Check switch settings.

Run Diagnostics utility.

o~ wnh =

Remove all devices except processor and replace one-
at-a-time until a failure occurs.

6. Replace the system board.
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Memory

Keyboard

Error
Code
0200-xx

0202-xx
0203-xx

0204-xx

0205-xxx
0209-xxx
0211-xx

0212-xxx

0214-xx
0215-xx

Error
Code
0300-xx

0301-xx

0302-xx
0304-xx

[]

Description
Machine ID test failed.

System ROM checksum failed
Write/read test failed.

Address test failed.

Walking 1s test failed.
RAM long test failed.

Random pattern test failed.
Cache test failed.

Noise test failed.

Random address test failed.

Description
ID test failed

Self-test/interface test failed.

Individual key test failed.
Repeat test failed.

Recommended Action
Reinsert memory modules and retest.

The following steps apply to 0202-xx through 0215-xx:

1.

Remove one memory module at a time until the error
message stops.

Replace other removed modules one at a time, testing
each to ensure the error does not return.

3. Replace defective modules.

If error continues, replace system board and retest.

The following steps apply to 0214-xx through 0215-xx:

1.

Remove one memory module at a time until the error
message stops.

. Replace other removed modules one at a time, testing

each to ensure the error does not return.

Replace the system board and retest.

Recommended Action
The following steps apply 0300-xx through 0304-xx:

1.

Check the keyboard connection. If disconnected, turn
the computer off and connect the keyboard.

. Replace the keyboard and retest.

3. Replace the system board and retest.

Holding any key down during the boot-up sequence causes the Basic Input Output
System (BIOS) to beep, as awarning of possible keyboard problems. Wait until
after the system has booted, then press the Num Lock key. If the Num Lock light
on the keyboard toggles on and off with each press of the key, the keyboard is
functioning properly.
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Parallel Port

Error

Code Description Recommended Action

0401-xx Failed or not connected The following steps apply to 0401-xx through 0403-xx:
0402-xx Printer port test failed. 1. Connect the printer.

0403-xx pattern test failed. 2. Check power to the printer.
3. Install the loop-back connector and retest.
4

. Replace system board and retest.

Diskette Drive

Error

Code Description Recommended Action

0600-xx ID drive types test failed. The following steps apply to 0600-xx through 0698-xx:
0601-xx Format failed. 1. Replace the diskette media and retest.

0602-xx Read test failed. 2. Reseat and/or replace the diskette power and signal

cables and retest.

0603-xx Write, read, compare test failed. 3. Replace the diskette drive and retest.
0604-xx Random seek test failed. 4. Replace the system board and retest.
0605-xx ID media test failed.
0606-xx Speed test failed.
0609-xx Diskette reset controller failed.
0610-xx Change line test failed.
697-xx Diskette type error.
698-xx Diskette drive speed not within
limits.
699-xx Diskette drive/media error. 1. Replace the diskette media and retest.

2. Run Computer Setup and TEST.

Serial Port

Error
Code Description Recommended Action
11017-xx Serial port test failed. 1. Run Computer Setup or Windows NT, Windows 95, or

Windows 98 utilities.

2. Replace the system board and retest.
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Modem Communications

Error

Code

1201-xx
1203-xx
1204-xx
1205-xx
1210-xx

Hard Drive

Error
Code
1701-xx

1702-xx
1703-xx

1704-xx
1705-xx
1708-xx
1710-xx
1715-xx
1716-xx
1717-xx
1719-xx
1724-xx
1736-xx

Description
Internal test failed.

External termination test failed.

Auto originate test failed.
Auto answer test failed.

Direct connect test failed.

Error
Format test failed.

Read test failed.
Write/read/compare test failed.

Random seek test failed.
Controller test failed.

Format bad track test failed.
Park head test failed.

Head select test failed.
Conditional format test failed.
ECC* test failed.

Power mode test failed.

Network preparation test failed.

Monitoring test failed.

*Error Correction Code

Recommended Action

The following steps apply to 1201-xx through 1210-xx:
1.

Disconnect from the phone line and retest.

2. Check the phone number.
3.
4

. Replace the modem and retest.

Check the modem line.

Recommended Action

The following steps apply to 1701-xx through 1736-xx:
1.
2.

I

Run Computer Setup and verify drive type.

Reseat or replace the hard drive signal and power
cables and retest.

Clear CMOS.

Run the hard drive DPS test.
Replace the hard drive and retest.
Replace the system board and retest.
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Tape Drive

Error
Code Description Recommended Action
1900-xx ID test failed. The following steps apply to 1900-xx through 1910-xx:
1901-xx Servo test failed. 1. Replace the tape cartridge and retest.
1902-xx Format or format verification 2. Reseat and/or replace the signal cable and retest.
test failed.
1903-xx Sensor test failed. 3. Check the switch settings on the adapter card (if
applicable).
1904-xx BOT/EOT test failed. 4. Replace the tape adapter card (if applicable) and retest.
1905-xx Read test failed. 5. Replace the tape drive and retest.
1906-xx Write/read/compare failed. 6. Replace the system board and retest.
1910-xx Tape erase test failed.
Video
Error
Code Description Recommended Action
507-xx Graphics controller test failed. The following steps apply to 501-xx through 516-xx:
502-xx Video memory test failed. 1. Replace the monitor and retest.
503-xx Video attribute test failed. 2. Replace the graphics controller and retest.
504-xx Video character test failed 3. Replace the system board and retest.
505-xx Video 80 x 25 mode 9 x 14
character cell test failed.
506-xx Video 80 x 25 mode 8 x 8
character cell test failed.
507-xx Video 40 x 25 mode test failed.
508-xx Video 300 x 200 mode color set 0
test failed.
509-xx Video 320 x 200 mode color set 1
test failed.
510-xx Video 640 x 200 mode test failed.
511-xx Video screen memory page test
failed.
512-xx Video gray scale test failed.
514-xx Video white screen test failed.
516-xx Video noise pattern test failed.
2407-xx Graphics controller test failed. 1. Reseat the video card (if applicable) and retest.
2. Replace the video card and retest.
3. Replace the system board and retest.
2402-xx Memory test failed. The following steps apply to 2402-xx through 2419-xx:
2403-xx Attribute test failed. 1. Reseat the video card (if applicable) and retest.
Continued
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2402-2419 Continued

Error
Code
2404-xx
2405-xx

2406-xx

2408-xx
2409-xx
2410-xx
2411-xx
2412-xx
2418-xx
2419-xx
2420-xx
2421-xx

2422-XxX

2423-xx

2424-xx

2425-xx

2431-xx
2432-XX

2448-xx
24517-xx
2456-xx
2458-xx

2468-xx
2477-xx
2478-xx
2480-xx

Description
Character set test failed.

80 x 25 mode 9 x 14 character cell
test failed.

80 x 25 mode 8 x 8 character cell
test failed.

320 x 200 mode color set 0 test failed.
320 x 200 mode color set 1 test failed.

640 x 200 mode test failed.

Screen memory page test failed.
Gray scale test failed.

ECG/VGC memory test failed.
ECG/VGC ROM checksum test failed.
Graphics attribute test failed.
ECG/VGC 640 x 200 graphics mode
test failed.

ECG/VGC 640 x 350 16 color set test
failed.

ECG/VGC 640 x 350 64 color set test
failed.

ECG/VGC monochrome text mode
test failed.

ECG/VGC monochrome graphics
mode test failed.

640 x 480 graphics test failed.

320 x 200 graphics (256 color mode)
test failed.

Advanced VGA Controller test failed.

132-column Advanced VGA test failed.

Advanced VGA 256 Color test failed.
Advanced VGA BitBLT test.

Advanced VGA DAC test.
Advanced VGA data path test.
Advanced VGA BitBLT test.
Advanced VGA Linedraw test.

Recommended Action
2. Run the Configuration and Diagnostics utilities.

3. Replace the monitor and retest.

4. Replace the video/system board and retest.

Replace the monitor and retest.
1. Reseat the video card (if applicable) and retest.
2. Replace the video/system board and retest.

The following steps apply to 2422-xx through 2456-
XX:

1. Reseat the video card (if applicable) and retest.
2. Run the Configuration and Diagnostics utilities.
3. Replace the monitor and retest.

4. Replace the video/system board and retest.

The following steps apply to 2458-xx through
2480-xx:

1. Reseat the video card (if applicable) and retest.
2. Replace the video card and retest.

3. Replace the system board and retest.
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Audio

Error
Code
3206-xx

Description

Audio System Internal Error.

Recommended Action
Replace the system board and retest.

Note: When Windows 95 or 98 are installed, changes to ESS sound device configuration do not take
effect until the computer is restarted (turned off and on).

Network Interface

Error
Code
6000-xx

6014-xx

6016-xx
6028-xx
6029-xx
6054-xx
6056-xx
6068-xx
6069-xx
6089-xx

Description
ID test failed.

Configuration test failed.”

Reset test failed.”

Internal test failed.”
External test failed.”
Configuration test failed.**
Reset test failed.*”
Internal test failed.**
External test failed.**
Open test failed.””

* Ethernet only.
** Token Ring only.

CD-ROM and DVD-ROM
Error
Code Description
3301-xx CD-ROM drive read test failed.
3305-xx CD-ROM drive seek test failed.
6600-xx ID test failed.
6605-xx Read test failed.
6608-xx Controller test failed.
6623-xx Random read test failed.

Pointing Device

Error
Code
8601-xx
8602-xx

Description
Mouse test failed.

Interface test failed

Recommended Action
The following steps apply to 6000-xx through 6089-xx:

1. Run Computer Setup or Windows NT, Windows 95,
or Windows 98 utilities.

2. Verify test procedures.
3. Replace the network card, if installed.
4. Replace the system board.

Recommended Action

The following steps apply to 3301-xx through 3305-xx and
6600-xx through 6623-xx:

1. Replace the CD media and retest.

2. Check the jumper settings on the adapter card.
3. Verify that the speakers are connected.
4

. Reseat and/or replace the power and signal cables
and retest.

5. Replace the CD-ROM drive and retest.

Recommended Action
The following steps apply to 8601-xx through 8602-xx:

1. Replace with a working mouse and retest.
2. Replace the system board and retest.
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Special Error Codes

This section includes the error codes for the following devices:

B SCSI hard drives

B SCSl tape drives

m SCSl| PD-CD drives

m All CD-ROM drives

The SCSI error codes consist of three components, AABB-CC, where
AA = Device Name

BB = Test Name

CC = Error Code

For example, adiagnostic error code of 6523-05 indicates that the diagnostics program was
testing the hard drive random-read function and received a seek failure. The device is faulty and
must be replaced.

Device Names

65XX-XX Hard Drive
B66XX-XX CD-ROM Drive and PD-CD Drive
67XX-XX Tape Drive

Test Names
XX00-XX ID
XX05-XX Read
XX06-XX SA/Media
XX08-XX Controller
XX09-XX Media erase
XX23-XX Random read
XX28-XX Media load/unload

Compaq Service Reference Guide
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Test Error Codes

Error Code Description

XXXX-02
XXXX-03

XXXX-05
XXXX-06
XXXX-07
XXXX-08
XXXX-09
XXXX-10
XXXX-11
XXXX-12
XXXX-13
XXXX-14
XXXX-15
XXXX-16

XXXX-17

XXXX-18

XXXX-21

65XX-24

66XX-24

67XX-24

XXXX-25
XXXX-30
XXXX-31
XXXX-32
XXXX-33
XXXX-34
XXXX-35

Drive not installed.
Media not in drive.

Seek failure.

Drive timed out.

Drive busy.

Drive already reserved.
Unknown.

Unknown.

Media soft error.

Drive not ready.
Media error.

Drive hardware error.
lllegal drive command.
Media was changed.

Tape write-protected.

No data detected.

Drive command aborted.

Media hard error.

Media hard error.

Media hard error.

Unknown.

Controller timed out.
Unrecoverable error.
Controller/drive disconnected.
lllegal controller command.
Invalid SCSI bus phase.
Invalid SCSI bus phase.

Recommended Action
Check cable connections.

Check for and install DATA CD or write-enabled tape

in drive.

Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.

Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.

1. Disable write-protect on tape cartridge.

2. Replace tape drive.

Replace the indicated device.

Replace the indicated device.

1. Back up data and perform Surface Analysis to

reallocate defect.

2. Replace drive.

1. Replace current DATA CD with different DATA CD.

2. Replace drive.

1. Ensure correct media type for this tape drive.

2. Replace current tape with new tape.

3. Replace tape drive.

Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.

Continued
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Test Error Godes Continued

Error
Code
XXXX-36

XXXX-39
XXXX-40
XXXX-41
XXXX-42
XXXX-43
XXXX-44
XXXX-50
XXXX-51
XXXX-52
XXXX-53
XXXX-54
XXXX-60
XXXX-61
XXXX-65

XXXX-90

XXXX-91

XXXX-99

Description
Invalid SCSI bus phase.

Error status from drive.
Target timed out.

SCSI bus stayed busy.
ACK/REQ lines bad.
ACK did not deassert.
Parity error.

Data pins bad.

Data line 7 bad.

MSG, C/D, and/or I/O lines bad.

BSY never went busy.
BSY stayed busy.

Controller CONFIG-1 register bad.
Controller CONFIG-2 register bad.

Media not unloaded.

Fan failure.

Over temperature.

Autoloader reported tapes not
loaded properly.

Recommended Action

Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.
Replace the indicated device.

1. Ensure fan(s) connected.

2. Replace nonfunctional fan(s).

1. Ensure proper air flow.

2. Perform required maintenance and cleaning.

1. Install tape(s) in autoloader tape drive according to test

instructions.

2. Change autoloader magazine.
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A

additional documentation, viii
air flow. See ventilation
Altiris eXpress, 3-2
AssetControl, 3-3

B

broken key icon, 3-6
Building Blocks and Partners,
3-19

(H

cable adapter
SCSl, 5-1
cable lock provision, 3-10
CD-ROM drive
device sequence, 4-1
chain termination
SCSI, 5-1
Computer Checkup (TEST),
2-10
Computer Setup
menu, 2-4
replicating, 3-17
Computer Setup Utilities
using, 2-2

D

deployment
remote, 3-3
device drivers
install or upgrade, 1-1, 1-2
device sequence
CD-ROM drive, 4-1
DVD-ROM drive, 4-1
LS-120 drive, 4-1
tape drive, 4-1
Zip drive, 4-1
diagnostic
diskette, 2-10
tests, 2-13

Index

diskette
diagnostics, 2-10
emergency repair, 1-2
DVD-ROM drive
device sequence, 4-1

E

emergency repair diskette, 1-2

Enhanced Support Software
CD, 3-18

error checking and correcting
(ECC)
fault prediction, 3-12
prefailure warranty, 3-12

F
FailSafe
Boot Block ROM, 3-14
key, 3-8

fault prediction, 3-11

/

icon,broken key, 3-6

ID numbers
SCSl, 5-1

Insight Manager LC, 3-3, 3-4,
3-11, 3-12

INSPECT, 2-11

install or upgrade device
drivers, 1-1, 1-2

Intelligent Manageability
defined, 3-1

K

keyboard
delimiter characters, 3-7
light combinations, 3-15

L

LS-120 drive
device sequence, 4-1

m

Microsoft Windows,
installing, 1-1

N

network
service boot, 3-2
NIC Alert, 3-16

0

operating system, installing,
1-1

P

password
delete, 3-6
establish, 3-5
power-on, 3-5
PC Transplant, 3-3
POST, 2-3
power button, dual state, 3-17
Power-On Self-Test (POST),
2-3
prefailure warranty, 3-11
preinstalled software, 3-2
protecting software, 2-14
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R

recovering
software, 2-14
registering the computer, 1-4
remote
Management Setup Utilities,
34
Security Management, 3-16
system installation, 3-2
Wakeup and Shutdown, 3-16
Remote Management Setup
Utilities, 3-12
Restore CD, 2-14

S

SCSl

cable adapter, 5-1

chain termination, 5-1

ID numbers, 5-1
Smart Cover

FailSafe key, 3-8

lock, 3-8

sensor protection level, 3-7
software

image, 3-2

protecting, 2-14

recovery, 2-14
symbols and conventions, vii
symboals, warning, vii
system installation

remote, 3-2
System Software Manager,

3-12

T

tape drive

device sequence, 4-1
technician notes, viii
TEST. See Computer Checkup
thermal sensor, 3-12

]

Ultra ATA integrity
monitoring, 3-11

4

ventilation, computer, viii
View System Information
(INSPECT), 2-11

w

warning symbols, vii

V4

Zip drive
device sequence, 4-1

-2

Index
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